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Course Description

Medicinal Chemistry is the study of how new drugs are developed and tested. In this course,
you learn the basics of drug's synthesis, drug design and development. Medicinal chemistry
requires an understanding of how chemistry, biology, mathematics and computing interact with
each other to allow the scientist to effectively create new pharmaceuticals that will prevent or stop
one or more disease conditions. This practical course in medicinal chemistry concerned with
multistep synthesis of selected medicinal compounds.

The successful medicinal chemist is an expert organic chemist who has, or can acquire,
sufficient knowledge in other disciplines to apply that knowledge to drug synthesis and design.
We shall have opportunities to illustrate the dependence of medicinal chemistry on knowledge
from other disciplines as we progress through this course. So our course will build on the
experience gained from organic chemistry lab through the synthesis and characterization of
complex molecules, the acquisition and interpretation of physical data and the investigation of
chemical systems through computational techniques gained in analytical and instrumental labs. It
consists of a series of laboratory-based experiments aimed at developing skills in the synthesis,
safe handling and analysis of chemical substances of a range of different classes of compounds;
an understanding of modern characterization techniques (e.g. chromatography, atomic and
molecular spectroscopy); and the operation of instrumentation for the acquisition of Kinetic,
structural and thermodynamic data.

In addition to increased proficiency in standard techniques, this course provides an
introduction into research-based chemistry through integrated and themed experiments. It will
provide skill development in a range of techniques utilized in the modern chemistry laboratory.
The subject provides experience across multiple traditional chemical disciplines whilst
highlighting the importance of these disciplines in diverse 'real world' applications such as
materials science and medicinal chemistry.

This Lab class is divided into two parts: the first part will focus on three synthesis cycles; multi
— step Synthesis of Sulfanilamide, Benzocaine and Phenytoin, using techniques of organic
compounds that an organic chemist uses daily; including crystallization, distillation, and
extraction and will be will be run in groups. The second part focuses on Molecular modeling using
computer software’s for drug design.

Course Objectives

Familiarize students with techniques commonly used in the medicinal chemistry laboratory.
Learn how synthesis a drug in multisteps and how get it in good yield and in pure form.
Demonstrate the effect of the different synthetic methodology.

Clarify theoretical concepts of chemical synthesis of drug molecules.

Working in the laboratory will give the students experience in handling and proper usage of
laboratory glassware, equipment, and chemicals.

6. The students should learn how to keep an accurate and readable record of all experimental
work and how to write a scientific report.

7. Students are expected at the completion of this course to master a variety of synthetic
techniques including purification methods and should gain the ability to design a synthetic
scheme for a proposed drug molecule.

8. Learn how to use different computer sofwares to draw & design drugs and learn how drug
interact with its target.

9. Equip students with both oral and written communication skills, through your practical report
and your written assignments and oral tasks, and through the communications that will be
engaged in with lecturers, demonstrators and classmates, especially in the group laboratory
work.
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Intended Learning Outcomes (ILOs)

Successful completion of the course should lead to the following outcomes:

A. Knowledge and Understanding:

1.
2.
3.
4,

To understand.

To know the structures of different drugs.

To know the general laboratory safety and basic techniques.
To understand the principle of drug synthesis.

B. Intellectual skills (cognitive and analytical):

1.
2.
3.

4,

To realize any mistakes done during the assay and try to avoid it.

To be able to create a chemical assay for identification the quality of drug.

The student is expected to develop the ability to suggest suitable techniques to
synthesis different drug molecules.

The student is expected to interpret scientific data and make sound scientific
conclusions.

C. Subject specific skills

The student is expected to learn how to conduct chemical reactions within medicinal chemistry
context this includes:

1.
2.
3.

4,

How to set up chemical instruments and tools in an experiment.

How to mix reactants, solvents and reagents within experimental context.

How to isolate and purify reaction products through (not limited to) chromatography,
crystallization, distillation.

Identification and characterization of the final products through standard chemical
procedures such as melting point, NMR, etc.

D. Transferable Skills

1.
2.

3.

Team work.

Use oral communication to effectively transmit ideas and conclusions to a scientific
audience.

Develop of problem solving and critical thinking skKills.

Reading List / References:
Supplementary Textbook(s)

1 Wilson and Gisvold's Textbook of Organic, Medicinal and Pharmaceutical Chemistry,
12th Edition, 2011, Lea & Febiger.
2 Foye's Principles of Medicinal Chemistry, David A Williams, William O Foye and
Thomas L Lemke, 6th Edition, 2008, Lippincott Williams & Wilkins.
3 Organic Chemistry: A Short Course. By Harold Hart, Leslie E. Craine, David J. Hart.
Publisher: Houghton Mifflin College; 10th edition (January 1999) ISBN. 0395902258
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Grade Distribution

Assessment Grade Date
1. Quiz 10% weekly
2. Midterm exam 30% To be arranged
3.Report 10% weekly
4. Evaluation 10% weekly
5. Final Examination 40% To be arranged

Important regulations

On average, students need to spend 3 hrs of study and preparation weekly.

Excellent attendence is expected. According to the university policy, students who miss
more than 15% of the lecture hours with or without excuse will be dismissed from the
course

At the beginning of the lab, be on time and don't leave before the end of the lab session
without an accepted excuse

If you missed a lab session, it is your responsibility to find out about any announcements
or assignments you have missed

For any clarification, please communicate your instructor at his posted office hours or by
appointment

Switch off your mobile or keep it silent throughout the lecture

Listen well to the lab disscution and avoid side discussions, if you have a question, ask
your instructor and not your collegue

If you have any information, document your reference, if you didn't, then you broke the
intellectual property rights law and the law will be applied

Exams are scheduled to be given two times throughout the semester, your are expected to
attend all. If not, make-up exams will be offered for valid reasons. It may be different
from regular exams in content and format.

Cheating, academic diconduct, fabrication and plagiarism will not be tolerated, and the
university policy will be applied

Each student is expected to familirize himself with laboratory rules and safty precution.
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General Instructions

A. Lab Safety Precautions

Gloves and Eye protection Goggles must be worn at all time in the lab,
regardless of what is being done. Prescription glasses (not sunglasses) are
acceptable. Contact lenses provide no protection.

Familiarize yourself with the location of fire extinguishers , safety showers,
fire blankets and eye wash fountains and know how and when to use these
devices.

If chemical are splashed in or near the eye, wash immediately with clean
and cold running water for 10 -15 min (remove contact lenses in case you
have been wearing them). Consult a physician afterwards.

When inserting glass tubing or thermometer into rubber stoppers, always
lubricate both the glass and the whole with glycerin and protect hands with
a towel.

Never taste any compound in the laboratory.

To determine the odor of a compound, bring the stopper of the bottle
cautiously toward the nose. Do not inhale.

Avoid any contact of chemicals with the skin, especially the face. Wash your

hands as soon as possible after making transfers or other manipulations.
When heating a test tube or carrying out a reaction in one, never point the
tube toward yourself or your neighbor.

Never heat an organic liquid directly over a flame except under a condenser.
When refluxing a liquid, be sure that the condenser is tightly fitted. If a
temperature below 95°C is sufficient, use a steam bath rather than a burner.
Before lighting a flame check to see that volatile liquids are not being poured
or evaporated in your vicinity.

Always turn a burner off as soon as you finish using it.

As a general practice, and particularly if a burner is in use, avoid loose-
fitting long sleeves and cuffs. Long hair should be tied back during
laboratory work.
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afe
Rules

Science labs offer great
opportunities for learning,
teaching, and research.
They also pose hazards
that require proper safety
precautions.

Stay safe

when
conducting
your labs by
following

these ‘

guidelines.

Proper
supervision

Don't perform lab expediments without instructor
SUPBrVISION [unless given permission 10 do o).

&<

Dress
appropriately

Tie back long kair, and wear suitahile gloves.
goggles, and other protective equipment

Know location of emergency
numbers & safety equipment

Know the lecation of safely equipmant and emergency phone numbers
{such as poison control) 50 you can ascess them quickly if necessary.

T,
Be attentive
ND fO{]d I D haza rds Be attentive while in the fab.

. _— . ) Don't feave lit Bunsen burners
Dan't gat ar drink in the lab— Identify Bazasdous materials unattended of leave an sxperi-
and never taste chemicals, before beginning labs. ment m progress.

Be careful when | |- -
handling hot glassware  _ -

Turn off all heating appliances when not in use, Keep flammahisz - 'v_,

obygects away from your workspace. 2222:=

ll
1l

=/ J

Il
Il

Keep

>
a clean Hand'e Clean up
workspace g Ia sswa re After completing the lzb,

o ] fully clean your workspace
Dear't obstruct work argas, care : .
fioors, or exits, Keep coats. CEI]‘EflI I Iy “gdrtﬂz;qu“ ipment, and wash
bags. and other personal items Properly dispose of anything you

stored in desigrated areas 1hal breaks. Report cuts,

awiay from the lab. Don't block spills. and hroken glass to

sink drains with detins. your instructor immediately

+ Any experiment involving the use or production of objectionable (i.e.

poisonous or irritating) liquids or gases, must be performed in the hoods.
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B. Laboratory rules

Each student is expected to attend each lab session and to be in the
laboratory on time. Those students, who come early, should wait inside the
lab but never gather in the corridors.

Each student must wear a clean and buttoned up lab coat with his\here tag

name before enter your lab.

Skirt, short clothe, sandal (open shoes) and head caps forbidden in lab.
Smoking, Drinking, Eating or Chewing gum is prohibited in the lab.

Each student is responsible for keeping the laboratory clean and in good
order.

Coats, book and personal belongings should be kept in your lockers. Do not
bring them with you to the lab.

All working areas and balances must be kept clean.

Powdered drugs, greasy or waxy materials or any insoluble waste materials
will block the sink if thrown in to it . Thus, dispose them properly in a waste
basket. Water immiscible organic solvents and other liquids should be
discarded in a designated waste — solvent can but never poured in to a sink.
Chemicals that react vigorously with water, such as acid chlorides or alkali-
metals should be decomposed in a hood in a suitable way.

If students are assigned to work as groups, each group is expected to work
quietly and independently.

Do not carry reagent bottles to your desk.

Never return excess materials to reagent bottles.

Each student must bring:

v" Two hand towels v' Marker

v Sponge for disk cleaning v' Pair of gloves (nitrile gloves is
v’ Detergent preferred)

v' Matches v' Calculator to each lab

You Will Be Held Responsible For Each Rule Mentioned Above,
Any Violation Will Expose You To Either Being Dismissed From
The Lab Or Losing Evaluation Marks Of That Particular

Experiment Without Prior Notification
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Common problems / easy solutions:

10-

11-

12-

NH4OH: Serious eye damage if contacts with eye. Very destructive to mucous
membranes. Corrosive — severe burns
Chlorinated solvents such as CHCIlz and DCM. Dispose in designated waste-
solvent bottles found inside the hood.

Chlorosulfonic acid : Corrosive acid that may cause severe skin mburns and eye
damage, vapor extremely irritating to lungs and mucous membranes and is fatal if
inhaled.

Alkali metals: must always be kept covered with dry organic inert solvent such as

Kerosene or paraffin oil. Remaining metal pieces, tools, knifes and spatulas must
be placed in a beaker, then treated with absolute dry ethanol and leave it bubble
(H2 gas) for minutes.

Mercury waste from a broken thermometer must be treated with solid sulfur
powder bit never thrown in the waste basket.

Ether is very volatile and highly explosive. Keep in cold place. Dry solvent
bottles on the shelves can be easily oxidized upon evaporation and leave explosive
compounds. Please inform the technician.

You must report any broken glass. Don not remove yourself.

Do not draw any liquid with your mouth or smell any chemical.

Concentrated mineral acids and bases should always be kept at the hood and
you should wear gloves when using.

Maintain labels on chemical containers received from manufacturers and label
secondary containers. Replace old and deteriorated labels.

Smelly chemicals such as acetic anhydride, glacial acetic acid, pyridine, and
benzaldehyde should be kept always in the hood and disposed in waste closed
bottles.

Radioactive material, biological and chemical hazards should be handled and
disposed in collaboration with faculty administration and local civil defense
agency following special protocols.



Labs common glassware

laboratory equipment
burette (afso buret)

test tube

Bunsen burner Volumetric flask ‘Wash bottle




Cycle 1
Multistep Synthesis of Benzocaine

O
/\O

NH,
Target Product

e Benzocaine is a local anesthetic from the ester family.

e The drug benzocaine is used in multiple forms including lotion, gel,
liquid, lozenges, and sprays as a topical pain reliever.

e When Benzocaine is applied in any form, it temporarily numbs or
blocks the nerve endings by inhibiting the voltage dependent Na
channels on the neuron membrane, which leads to decrease in the

amount of pain.


https://en.wikipedia.org/wiki/Neuron
https://en.wikipedia.org/wiki/Cell_membrane

General scheme of synthesis

CH3 (I:H3 CH3
C ot
N CH,COONa
. O/ \O 3
CH;COOH
HN HaC o) Acetylation HN
p-Toluidine Acetic anhydride COCH,
N-Acetyltoluidine
Oxidation
KMNO,
/Csz MgSO,
o
COOH COOH
Acid HydronS|s
EtOH 1) HCI/Hzo
2804 2) 10% aq. NH4
Esterlflcatlon
HoN
PABA
Benzocaine COCH3

p-Acetamidobenzoic acid

Four-step synthesis is used to create benzocaine:

Part 1: Synthesis of p-Acetotoluidide

Part 2: Synthesis of p-Acetamidobenzoic acid

Part 3: Synthesis of p-Amino benzoic acid (PABA)
Part 4: Synthesis of Benzocaine

You will see the mechanism only for the forth steps.




Experiment 1

Multistep Synthesis of Benzocaine

Part 4: Benzocaine synthesis
HO 0 T o
0
b oo N + H,0
Ethanol
NHz NH,

p- aminobenzoic acid
Ethyl p-aminobenzoate

PABA (Benzocaine)

e Benzocaine is synthesized through the Fischer esterification of p-

aminobenzoic acid (PABA) and ethanol, using sulfuric acid as a
catalyst.
e PABA: is amphoteric that has weak acidic and weak basic

properties.

5 Assignment
5.1 Find a commercial synthesis pathway of PABA.
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Mechanism

COOH COOCH,CHy
+  CH,CH,0H —_— +  H0
H,N HoN

e This reaction is called Fischer esterification reaction: a type of

condensation reaction (both way reaction- limited yield)

e [tisacid catalyzed (it not consume in the reaction).

e |t proceeds very slowly in absence of strong acids as HCI or H2SO4.

+

. +
HO (0]
et HO OH HO o
/w \H
) \
—_— HO/\ -
NH NH3
®

NH3
. ®
p-aminobenzoic acid
Proton
transfer
o
2
o) 0 /o ( O/\
w w H A
Hydrolysis
HaO
- NaCOs S
Neutralization Acid not
of acid to ppt consume
product | (1t is catalyst)
NH2 %Ha NH3
®

To increase the ester yield :

- Use excess from the reactants
- Remove water from reaction mixture as it is formed
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Procedure

1. In a 100 ml round-bottomed flask place 1.32 g of PABA, 10 ml of
ethanol, and 1 ml of sulfuric acid (add cautiously). Add a couple of

boiling chips” then attach a reflux condenser and heat under reflux for

1 hour.

2. Cool the solution to room temperature, neutralize with 10% sodium
carbonate (foaming), and extract® with two 10-ml portions of
dichloromethane (DCM) [use separatory funnel in extraction]. Then dry the
combined organic layers over anhydrous magnesium sulfate [drying
agent].(l)

3. Remove the dichloromethane by distillation using a steam bath as a heat
source.

4. Then recrystallize the residue from methanol-water [Mixed solvent

recrystallization?].??

(1) Add 3-4 gm of anhydrous magnesium sulfate, swirl the mixture for about 5 minutes, and
then remove it by gravity filtration.

(2) Add 5 ml portions of methanol (with heating) until all the amount is dissolved, then add
water drop wise until the solution becomes turbid, after that cool it in an ice bath to complete

crystallization.

Weight (gm) M.P

Benzocaine

2 Brain storming Question

2.1 Discus the reason behind doing extraction in DCM, and define the component for
each layer.

2.2 Discus the reason behind adding drying agent for the organic layer.

“Refer to appendix V: Boiling chips
Refer to appendix I11: Recrystallization-Mixed solvent recrystallization.
“Refer to appendix VII: Extraction.
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pre-lab.
Report sheet (1)

Synthesis of Benzocaine

Student name:

Obyjectives :

MW Solubility
(g/mol) | in water

Compound Hazards

p-
aminobenzoic
acid
HCI

Benzocaine

Find out :
1. Mwt of Benzocaine...............
2. ‘The melting point of Benzocaine .............

Draw a simple flowchart for the procedure of the exp. Or write an outline steps in
your own words?




Post-lab.

Report sheet (1)

Synthesis of Benzocaine

Student name:

1. data and results:
The actual yield of Benzocaine:

The theoretical yield of Benzocaine(show detailed calculation):

The yield%:

2.chemical equations:
Write down the balanced chemical equations that represent the
preparation of Benzocaine:



Cycle 2
Multistep synthesis of Phenytoin

Phenytoin, sold under the brand name Dilantin among others.

It is an anti-seizure medication.

It is useful for the prevention of tonic-clonic seizures and partial
seizures.

Phenytoin blocks the spread of seizure activity in the brain by
causing voltage dependent block of the voltage gated Na channels.
It may also be used for certain heart arrhythmias or neuropathic pain.
It doesn’t have sedative hypnotic activity

It can be taken intravenously or by mouth


https://en.wikipedia.org/wiki/Anticonvulsant
https://en.wikipedia.org/wiki/Tonic-clonic_seizure
https://en.wikipedia.org/wiki/Partial_seizure
https://en.wikipedia.org/wiki/Partial_seizure

General scheme of synthesis

= o o OH
Thiamine Hydrochloride
NaOH -
Ethanol

Benzaldehyde Benzoin
cat.Cu(C,H;30,),
o Acetic acid

H,_N —C— NH,
NaOH]Ethanol

5,5-diphenylhydantoin
(Dilantin)

Phenytoin can synthesize from benzaldehyde in three synthetic steps:

Part 1: Benzoin condensation.
Part 2: Oxidation of benzoin to benzil.
Part 3: Condensation of benzil with urea to form phenytoin.

You will see the mechanism for each steps.




Experiment 2

Multistep synthesis of Phenytoin

Partl1: Benzoin Condensation

/O o) OH
Thiamine HCL
NaOH
2 >
Ethanol

Benzaldehyde Benzoin

e Benzoin is produced by dimerization of 2 molecules of
benzaldehyde, The benzoin condensation® is in fact a dimerization
and not a condensation because a small molecule like water is not
released in this reaction

e This reaction doesn’t occur spontancously. It needs a catalyst to

render the aldehydic carbon acidic so that it can be deprotonated and

function as a nucleophile to attack the second benzaldehyde carbon.
e Cyanide* [K*C = N~] can use as a catalytic reagent use at 75°C
(give faster rate) but they are extremely poisonous.
e Thiamine (contains a thiazole unit) is the catalyst was used here at

Room temp, (give very slow rate).

- Thiamine (Vit B1) is non-toxic (edible) material
- Thiamine is heat sensitive and may decompose if heated vigorously
- Instead of running the reaction at elevated temperature. We will allow

it to proceed closer to room temperature for at least 24 hours

SCondensation reaction: a reaction in which two molecules combine to form a larger molecule,
producing a small molecule such as H,O as a by-product.
Refer to appendix VIII: Benzoin condensation using cyanide.

-10-



Mechanism

First: Formation of the catalyst (Ylide™):

Acidic proton
N NH,

\Q; /
a N / 6[/’ 3 OH

Thiamine HC1

R Ylide (Catalyst)
Second: The condensation reaction start with umpolung? to the carbonyl center of
benzaldehyde:

AC|d|c proton

C/ '\ rlch center
Proton transfer E\

benzaldehyde
Other molecule
e-difficult center

e-difficult center

8) OH proon S & _
@4 | it /N | | @

Anti- elimination

)
OO

*Yalide: is a species with opposite formal charges on adjacent atoms (both on same bond, no distance

between them like in zwitter ion).
zwitter ion: a molecule or ion having separate positively and negatively charged groups.

H

*Umpolung or polarity inversion in organic chemistry: is the chemical modification of a functional
group with the aim of the reversal of polarity of that group. This modification allows secondary
reactions of this functional group that would otherwise not be possible.

-11-



Procedure

. In a stoppered E. Flask, prepare a solution of 1.04 g of thiamine
hydrochloride in 3 ml of water*.

. When all the thiamine hydrochloride has dissolved, add 8 ml of 95%
ethanol with mixing.

. Cool the solution for a few minutes in an ice bath [because thiamine is heat
sensitive].

. Very carefully and slowly add 3 ml of 10% NaOH with mixing “making

sure that the temperature of the solution never rises above 20 C” [because
NaOH with water exothermic].

. Add to the mixture 7 ml of pure Benzaldehyde with mixing.

. Stopper the flask and allow it to stand at room temp at least overnight
(longer period do no harm). At the end of the reaction period, the
benzoin should have separated as fine crystals.

. Cool the reaction mixture in an ice bath to complete the crystallization.
. Collect the product by vacuum filtration and wash them thoroughly with

two 7 ml portions of cold 50% ethanol and several portions of water®
[color change from yellow to white].

. Drainwell and leave your product to dry (no need for recrystallization™).

Weight (gm) M.P

Benzoin

3 Brain storming Question

3.1 Discus the chirality of the product, does it optically active? Explain your answer.

*Water is required in this reaction BUT in specific amount:

- Too much water will force benzaldehyde out of the solution preventing an efficient reaction.
- Too little water prevents thiamine-HCI from dissolving.

*Re-crystallizion an done using 95% ethanol.
§ Ethanol to remove excess benzaldehyde and water to get rid of thiamine.

-12-



Pre-lab.

Report sheet (2)

Benzoin Condensation

Student name:

Objectives :

MW Solubility

(g/mol) | in water Hazards

Compound

Thiamine
hydrochloride

NaOH
Benzaldehyde

Benzoin

Draw a simple flowchart for the procedure of the exp. Or write an outline steps in
your own words?
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Post-lab.

Report sheet (2)

Benzoin Condensation

Student name:

1. data and results:
The actual yield of Benzoin:

The theoretical yield of Benzoin (show detailed calculation):

The yield%:

2.chemical equations:
Write down the balanced chemical equations that represent the
preparation of Benzoin:

-14-



Experiment 3
Multistep synthesis of Phenytoin

Part2: Oxidation of Benzoin to Benzil

Preparation of benzil can be done by Mild oxidation of benzoin using

catalytic oxidation reaction, nitric acid or any other mild oxidizing agent,

where the OH group is converted to a ketone group.

OH o

Q o
cat.Cu™¥/ NH,NO,
—_—
Acetic acid

Benzoin Benzil

e Benzoin can be oxidized to the diketone benzyl using a Cu?* salt and
ammonium nitrate. Only catalytic amounts of copper(ll) acetate are

necessary because the Cu?* is continuously recycled.

benzoin benzil
2 Cult 2Cut
N2 + 3H20 NH4NO3 + 2H+

e Cupric acetate (Cu™) is used in a catalytic amount (less than 1% of
stoichiometric requirement) and is continuously re-oxidized from
the reduced (cuprous state Cu®) by ammonium nitrate (NO3") which
is present in excess and is reduced to ammonium nitrite (NO2") which

decompose in the reaction mixture into nitrogen gas.

Refer to appendix IX: Oxidation of Benzoin to Benzil using nitric acid.
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Mechanism

The reaction is
Coupled Oxidation; using Cu*? as the catalytic transfer oxidant.

Blue color
NH,"NOj" ~— Benzil QS vellow color
LSk S
NH,"NO," Cu Benzoin Whne color
Yellow color

Decomposition

In the first redox cycle, benzoin donates an electron to Cu?*, forming Cu* and
benzoin redical cation A.

The benzoin radical cation loses a proton to acetate ion (AcO), forming
acetic acid(AcOH) and a resonance stabilized radical, depicted by structure
B and C.

Another redox cycle between Cu?* and the radical takes place, forming a
second Cu* ion and cation D, which loses a proton to another acetate ion to

form benzil.
H Cu* H Cu*

ol% -gllo -oto

AcO AcOH

benzoin

oo~ @fC‘ ‘o~ 070

Cu?*

The Cu* ions formed in these redox cycles are re-oxidized to Cu?* by
ammonium nitrate, which is present in excess. Forms ammonium nitrite
(NHsNO), which decomposes to nitrogen and water under the reaction
conditions.

2Cu* + 2H* + NH,NO, — 2Cu®** + H,0 + NH,NO, - 2Cu*" + N,T + 3H,0

7 Assignment

7.1 Find other Mild oxidizing agents.
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Procedure

. In a round bottomed flask place 1.75 g of unrecrystallized benzoin, 5
ml of glacial acetic acid, 0.8 g of pulverized (reduced to fine particle)
ammonium nitrate, and 1 ml of a 2% solution of cupric acetate.

. Add 1-2 boiling chips, attach a reflux condenser and bring the solution

to a gentle boil. As the reactants dissolve, evolution of nitrogen begins.

3. Boil the blue solution for 1.5 hr to complete the reaction.

. Cool the solution to 50-60°C and pour it into 10 ml of ice-water mixture
in a beaker [to ppt product, since benzil insoluble in water], While stirring it. Then
Benzil separates out as yellow oil, which immediately solidifies.

. After crystallization of benzil is complete, collect the crystals on suction
filtration and wash them thoroughly with water.

. Press the product as dry as possible on the filter.

. If desired, it may be purified by re-crystallize from methanol or 75% ethanol. (After
dissolving the product in hot ethanol, add water dropwise to reach the cloud point

and allow it to crystallize).

Weight (gm) M.P

Benzil

4 Brain storming Question

4.1 Discus the chirality of the product, does it optically active? Explain your answer.
4.2 What structural features make benzil yellow and benzoin colorless (white)?
4.3 Would you have obtained the same results for the oxidation of benzoin if the label

on the copper acetate bottle had read “cuprous acetate?
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pre-lab.

Report sheet (3)
Oxidation of Benzoin to Benzil

Student name:

Objectives :
MW
Compound (e/mol) Hazards
Benzoin

Ammonium nitrate
Cupric acetate

Benazil

Find out the melting point of Benzil ?

Draw a simple flowchart for the procedure of the exp. Or write an outline steps in
your own words?
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Post-lab.

Report sheet (3)
Oxidation of Benzoin to Benzil

Student name:

1. data and results:
The actual yield of Benzil:

The theoretical yield of Benzil(show detailed calculation):

The yield%o:

2.chemical equations:
Write down the balanced chemical equations that represent the
preparation of Benzil:
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Experiment 4
Multistep synthesis of Phenytoin

Part3: condensation of Benzil with urea to form
Phenytoin (Dilantin ®)

o
HO
_ NH _
: g =
HN
ﬂ o HN =SS
H,N— ~ T~NH, -~
e
1. NaOH/Ethanol
2.H;0"
Benzil

5,5-diphenylhydantoin
(Dilantin)

e The preparartion of phentytoin carried out by the condensation of

urea with benzil in basic media (catalyst).

e The reaction involves a skeletal re-arrangement step (Benzylic acid
re-arrangement), both phenyls ending up on the same carbon atom.

e The rearrangement may occur due to the stability of imide (CO-NH-
CO) group that drives it or due to formation of benzyl cation (very
reactive- very high-energy intermediate).

e Acidification step is required to precipitate phenytoin

e Possible intermediates:

~ _~

[
0 0 Ph— K —Ph

[l HN NH
Ph/’C_C‘“‘Ph T
HN._ _NH, ©
\ér Pinacol

rearrangement

Benzilic acid intermediate intermediate

4,5-diphenyl-4,5-dihydroxyl imidazolone

Migration reaction: is slow reactions need heat (thermodynamic reaction root)
Give a very stable product due to very high transition stat energy for the intermediate.
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Mechanism

NH, NaOH

H H30* H
+ 0 N N
NH, HeOfethanol O =0 workup =0
N
benzil urea
Na phenytoin (Dilantin)

The mechanism of this reaction begins with the nucleophilic attack of a urea nitrogen
atom on one of the carbonyls of benzil, then itermoleculare cyclization and end up
with Benzylic acid re-arrangement
(Migration reaction).

Suggested Mechanism (1)

o.
H o _iOH H,
SV 0. o= H
“ee ~/ O N O —
N—H N—H o o0 =

. O
~ Co:
N Lo (/aNegt
N HoN
o H H,) o
O ..
|
a Benzilic acid
rearrangement step!

9 Y ) on
—N (:o:;@ ﬁ\l\ N 6‘ .0
O \IH - (. ﬁ>:o T O ”‘>——P,:

@ :0: °©
© [
&0 W, P v
N HgO*-Workup H N
Opo = | oy [— o
o N\H Y N o) B

phenytoin (Dilantin)
Imid proton is

subtracted rather than
amid proton
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Suggested mechanism (2):

This reaction is proceeding via intermolecular cyclization to form an intermediate
heterocyclic pinacol (4,5-diphenyl-4,5-dihydroxyl imidazolone), which on
acidification yield hydantoin (phenytoin) as a result of 1,2-diphenyl shift in pinacol

rearrangement reaction.

H
HI" phﬁ.--"""”
A, 1. NEQHC H.OH

HN H

=

Cm I‘. N
M
H W'_f
—l
Pinmcol

rearrangoment Ph-—Du

Benzylic acid re-arrangement (general mechanism)

OH

\\*-J?;rﬁ HO 7
R - R ——
1 ﬂ)\Fr 2

o)

o
Ho@\%-o
R_s
R

3

L&)
#¥
Rearrangement HD"-"iT,;D
intermediate E--',.--"E
-Slow moving- R H
Ha?'
O
O-H H0 - O-H g "
H—CI”]IV( 0N H-O
RR & R 5 ) RR 4
H
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Procedure

Because Dilantin® has significant biological activity, it is very important that
protective gloves and safety goggles be worn when handling the product of this
reaction!

. Inasmall round bottomed flask place 400 mg of unrecrystallized benzil,
200 mg of urea, 6.0 ml of ethanol, and 1.2 ml of 30% NaOH.

. Attach an upright condenser, add a boiling chip, and boil the mixture
gently for at least one hour.

. Cool the reaction mixture, add 10 ml of water, and filter the solution to

remove a sparingly soluble side product [pinacol side product] that

sometimes forms.
. Acidify the filtrate with 3-4 ml of HCL (20%) to pH 2-3. Then collect

the product on a suction filter, and wash it thoroughly with water.

Weight (gm) M.P

Phenytoin
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Pre-lab.

Report sheet (4)
Synthesis of Phenytoin

Student name:

Objectives :

MW [Solubility

(g/mol) | in water Hazards

Compound

Urea
NaOH

HCI
Phenytoin

4,5-diphenyl-4,5-
dihydroxyl
imidazolone

Find out the melting point of Phenytoin ?

Draw a simple flowchart for the procedure of the exp. Or write an outline steps in
your own words?
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Post-lab.

Report sheet (4)
Synthesis of Phenytoin

Student name:

1. data and results:
The actual yield of Phenytoin:

The theoretical yield of Phenytoin(show detailed calculation):

The yield%o:

2.chemical equations:
Write down the balanced chemical equations that represent the
preparation of Phenytoin:
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Cycle 3
Multistep Synthesis of Sulfanilamide

HQN@SOZNHZ

Target Product

Sulfa drugs were discovered in the early 1900°s and found to be active anti-
bacterial agents. Sulfanilamide inhibits the formation of folic acid in

bacteria, thus preventing its further growth.

e Sulfanilamides are sulfonamide synthetic anti-bacterials.

e Were the 1st successful selectively toxic antibacterial drugs.

e Used for treatment of acute uncomplicated UTI caused by E- coli,
malarial infections, vaginal yeast infection and ocular infection

e Toxicity: Kidney damage (stones formation), hypersensitivity

reactions.

1 Assignment
1.1 Find the story for discovery of sulfonamide as anti-bacterial drug.
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General scheme of synthesis

Nltratlon
Fe, HCI
H,S80, /SOE

Benzene Nitrobenzene Aniline

Acetylation
(CH;C0),0

NHCOCH,

NHCOCH; NHCOCH,
NH3/ H,0 C1503H @
Chloro sulfonation

Clos Acetanilide

HaNO,S
2_ ’ ) p-AcetamidobenzeneSulfonyl chloride
p-Acetamidobenzenesulfonamide

1-H;0%/ Heat
Acid Hydrolysis 2-HCOy

NH,

Intermediate

HzNOzS

Sulfanilamide ( Final product )
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Step1: Nitration of benzene.

HNO;
sto4 / 50C

Benzene Nitrobenzene

Mechanism:

1- Activation of nitric acid ( protonation of nitric acid to form
nitronium ion)
HONO, +2H,80, =<— H,0+HSO,+NO,

2- Electrophile aromatic substitution mechanism.

Q
II | -
HQ—N—o~ Hfz)soaH e HO+—|N+—O-_ + Hso,
H
i
+ + - +
HO—N-—0 — H0 + O=N=0
Y
H

Gl -
©+H
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Step2: Chemical reduction of Nitrobenzene to Aniline

1 Fc HCI
2. NaOH

Nitrobenzene Aniline
NO, NH.*
Sn/Zn
Reflux 30 min @ Neutrallzatlon @
Nitrobenzene Aniline salt of excess Aniline
HCL
Nofice the posiively
chamed ion formed.
MOz NHg*

@ + 7H* + Be- B @ + 2H:20

Sulfanilamide is easily synthesized from aniline in four steps. You will

see mechanism for each steps.
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EXperiment 5

Multistep Synthesis of Sulfanilamide
Part 1: synthesis qf acetanilide

Acetylation
Reaction
{CHgCO}zO
+ CH3COOH

Aniline Acetanilide Acetic acid

NHs> is an electron donating group that directs the electrophilic
aromatic substitution on ortho-para position (it is electron reach so

good nucleophile).
Aniline resonance

® @ @

*NH, NH, NH, NH, *NH,
O~ 0—Q—0—0
@

1 2 3 4 5

Acetanilide resonance

:jz ot

H. ™

~if Hoeh
3

)
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Acetylation of NH,- [ convert amine group to amide group]
It was for:
v" Protection
v" Blocking ortho and para director:

e Acetyl group (Bulk) makes steric hindrance and blocks the ortho
position so sulfonyl chloride group will be added to para position in
the next step

NH, H,0 NHSOH
O =0 =0
—

S0 S0
‘ 3 \ 3 i NHCOCH, NHCOCH,
[ j " NHsHS0, [ :[ i + QIS0 ——— -
HOO,S: SO.H
\iﬂl/ s N

NH, HS0,

HOs ¥
Figure 2. Sulfonation of Acetanilide
Directed only to the para position

Figure 1. Sulfonation of aniline all positions (o,p,
amine) are possible option

e Acetyl group will also protect from polymerization that may occur
between sulfonyl chloride from one molecule and the amine group
from another molecule and give polymeric material containing
sulfonamide linkages.

NH; NH, 0,8—NH
@ ) @S — Q Q
a —_—
Clo,s CIO,S HN\ /SOZ

Figure 3. Polymerization

e The free amine, under the strong acid conditions of
chlorosulfonation, would protonate or react with strong Lewis acids
present (such as SOg), resulting in deactivation of the ring toward
chlorosulfonation and sulfonation of the free amine.

. +
NH, NH;
©/ strong acid ©/
—_—

activated deactivated
Figure 4. Protonation of aniline in acidic condition

1 Assignment
1.2 Find other amine protective groups.
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Mechanism

Acetic anhydride

Aniline
This reaction is
a nucleophilic addition-elimination reaction

e Acetic anhydride is used instead of acetic acid because its carbonyl

carbon is more electrophilic than that of acetic acid so the amide
formation will be faster and easier otherwise it may need reflux for
3-4 hours.

o lo) N——C——0——COCH;
C l CHs
Addition
H3C 0 CH3 >

Acetic anhydride

o/ /ff)
. &

Aniline

Elimination

H3COC

@ E]
H 4 CHCOO

Acetic acid Acetanilide

1 Brain storming Question

1.1 Explains in your words the following side reaction (di-acetylation of aniline) and
comments on its rate? Is it faster or slower than the previous reaction? How can
minimize this side reaction?

HyCOC
A\

NHCOCH;3 N——COCH,

(CH;C0),0
—

Acetanilide Diacetylated aniline

1.2 Mention another side reaction suggested to be happen during this experiment.
How can minimize this side reaction?
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Procedure

1. Place 16 ml of aniline, measured using a 25ml-graduated cylinder, in to
a 500 ml Erlenmeyer flask.

2. Add 120 ml of water to the flask and then while swirling the flask add
20 ml of acetic anhydride [measure it using a dry cylinder] in several small
portions.

3. Add 200 ml of water and boiling stones (chips)#, and then heat until the
entire solid and oil have dissolved.

4. Add about 1 gm charcoal slowly to the main hot solution. Swirl the
mixture and boil gently for 5 min.

5. Filter through hot gravity filtration* into a 500 ml Erlenmeyer flask.
Have available 100 ml of boiling water for washing.

6. Cool the filtrate in an ice water bath for 15 min to complete the
crystallization.

7. Filter [cold suction filtration*], then dry the crystals and determine the

m.p”.

Weight (gm) M.P

Acetanilide

1 Brain storming Question

1.3 Justify the following:
A. Water used as solvent instead of acetic anhydride in this reaction?

B. Addition of water to aniline with swirling (shaking)? Addition of acetic
anhydride in several small portion?
C. Hot filtration.

“Refer to appendix I1: Melting point. To measure M.P.
*Refer to appendix Il1, Part II: Filtration techniques.
# Refer to appendix V: Boiling chips.
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Pre-lab.

Report sheet (5)
Synthesis of acetanilide

Student name:

Objectives:

Miscibility
Compound with solvent | Hazards
1
(g/mol) (water)

Aniline

Acetic
anhydride

Charcoal

Acetanilide

Find out:
1. The density of Aniline............
2. The density of Acetic anfydride
3. The melting point of Acetanilide .............

Draw a simple flowchart for the procedure of the exp. Or write an outline steps in
your own words?




Post-lab.

Report sheet (5)

Synthesis of acetanilide

Student name:

1. Data and results:
The actual weight (yield) of acetanilide:

The theoretical weight (yield) of acetanilide (show detailed calculation):

The yield%S:

2. Chemical equations:
Write down the balanced chemical equations that represent the
preparation of acetanilide:

SRefer to appendix I: Percent Yields Calculations.
To calculate % yield.
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EXperiment 6

Multistep Synthesis of Sulfanilamide

Part 2: synthesis of p-acetamidobenzenesulfonyl
chloride

(o]
0O )k
)]\ HN
HN
CISO3H
+ HCI + H,80,

Two

equivalent
O=—S=—=0

Acetanilide
Cl

4-Acetamidobenzene-
sulfonvl chloride

In__This Experiment perfectly dry acetanilide is treated with

chlorosulfonic acid, a highly reactive reagent. The hydrogen chloride

evolved is trapped; the reaction mixture is added carefully to water; and

the product, p-acetaminobenzenesulfonyl chloride, is isolated by filtration.
e This reaction is conducted without solvent

e Water serves to hydrolyze the excess chlorosulfonic acid and to stop
the reaction [ CiS5O3H+H 0 = HCI+H3504+ A

CAUTION: Chlorosulfonic acid is a corrosive chemical and reacts
violently with water. Withdraw with a pipette. Neutralize any spills and
drips immediately. The wearing of gloves and handling in the

hood is required.

2 Brain storming Question
4.4 Discus the effect of water on the product (p-acetaminobenzenesulfonyl chloride)
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Mechanism

This reaction is more complicated than it looks at first inspection.
It is happen in two steps.

Step 1: Exothermic reaction (spontaneous).

e The electrophile that initially adds to the ring is probably SOs,
forming the sulfonic acid (Ar-SOsH). The initially formed
substitution product is the sulfonic acid.

v’ Substitution is essentially, all para due to combined electronic and

steric effects.
first: CISO3H < 505 (g) + HCL (g)

9 o %

2® 2@ 2@
5 SR ok o 5%

(1]
NHCOCH; NHCOCH;,

@ +CISO)H ——————F +HCl + A

HO,S
p-Acetamidobenzenesulfonic acid

Step 2: Endothermic reaction (nonspontaneous).

e The sulfonic acid is then converted to 4- acetamidobenzenesulfonyl
chloride (Ar-SO,CI) by reaction with excess chlorosulfonic acid,

generating sulfuric acid as the co-product.

NHCOCH; NHCOCH,

A
+CISOH ——— + H,80,

HO;S Clo;8
p-Acetamidobenzenesulfonic acid

This reaction is:
Typical electrophilic aromatic substitution

Byproducts of this reaction : HCI (g), H2SO4 (g) , SOs3 (g) gas and heat (Since the
overall reaction is exothermic)

Other suggested mechanism summarized in appendix VI.
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Procedure

1. To a dry 100 ml Erlenmeyer flask, add 40 ml of Chlorosulfonic acid

(CISO3H) carefully while the flask in an ice bath. [corrosive and reacts
violently with water]

2. Add 15 g of dry finely powdered [7s4 for rxnj Acetanilide in small

portions and with good mixing. [because it is vigorous reaction]

3. Allow the mixture to warm at room temperature and then heat the
mixture on a steam bath for 30 min. (Adjust the temperature to 50 -
60°C). [to complete the reaction —step 2]

4. Cool to room temperature (using an ice bath). Place 400g of crushed
ice and 65 ml of D.w [water for ease stirring and and to get read of excess C/S0;H]
in a large beaker and pour the reaction mixture slowly and carefully
with stirring [to prevent caking — keep product suspended] onto the ice.

5. Rinse the flask with a little of cold water and transfer this to the beaker.

[Fill the flask with water and leave it under fume hood to the end to get read of all gases
out: HCL ,SOs]

6. Collect the crude material by suction filtration [Cold Suction Filtration] and
wash the precipitate with a small amount of cold water.
7. Recrystallize* the product from 200ml Chloroform ®. The purified

product should be dried in air to be used in the next lab.

[the chloroform used in recrystallization bcz the product soluble in it at high temp and ppt

at low temp]

@ Dissolve the crude material in hot chloroform, and while the solution is still hot, put it in a

preheated separatory funnel and take the lower organic layer. [To remove residual water bcz

the product sensitive to it]
Evaporate part of the chloroform until reach 200ml [keep your eyes on it will heating]
and cool the solution to R.T then in an ice bath, then collect the crystals and wash them

with cold chloroform. [Cold Suction Filtration]

Step 1-5 under fume hood.
‘Refer to appendix I11: Recrystallization.
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Weight (gm) M.P

p-Acetamidobenzenesulfonyl chloride

2 Brain storming Question
4.5 Discus cooling step (4) and use of both water and ice.

4.6 Discus is it possible to use drying agent like (MgSO4) instead of using extraction
and separation step in recrystallization.

4.7 In recrystallization you used separatory funnel for sepration describe component for
each layer.

4.8 In recrystallization‘Evaporate part of the chloroform until reach 100m1’. Why?
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Pre-lab.

Report sheet (6)
Synthesis of p-acetamidobenzenesulfonyl chloride

Student name:

Objectives:

MW Stability
(g/mol) |in water

Compound Hazards

Chlorosulfonic acid
Acetanilide

Chloroform

p_
acetamidobenzenesulfonyl
chloride

Find out the melting point of p-acetamidobenzenesulfornyl chloride?

Draw a simple flowchart for the procedure of the exp. Or write an outline steps in
your own words?




Post-lab.

Report sheet (6)
Synthesis of p-acetamidobenzenesulfonyl chloride

Student name:

1. Data and results:
The actual weight (yield) of p-acetamidobenzenesulfonyl chloride:

The theoretical weight (yield) of p-acetamidobenzenesulfonyl chloride
(show detailed calculation):

The yield%o:

2. Chemical equations:
Write down the balanced chemical equations that represent the
preparation of p-acetamidobenzenesulfonyl chloride:
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Experiment 7

Multistep Synthesis of Sulfanilamide

Part 3: synthesis of p-acetamidobenzene-
sulfonamide

NHCOCH, NHCOCH,

NH,OH

Heat >

+ HCI

N
Clozs (l-«zN?zs

4-Acetamidobenzene-

Solfonyl chiodde 4-acetamidobenzene

sulfonamide

A whole family of sulfa drug is possible at this stage if any other amine

RNH2 is used instead of ammonia.

Examples:

H N_<: }.IEE,::J
Sulfathiazole aTw-@
Sulfamethoxazole H

Sulfamethizole HN— ) fﬁiﬁh"
=N
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Mechanism

p-acetamidobenzenesulfonyl chloride

L e
SOREEVERI
\S 0] \S 0
N\ I\

:NH; i H% :

The H on the amino N atom is fransferred to the negatively charged oxygen
Ammonia reacts with the electrophilic sulfur atom
and breaks the 5=0 bond.

T
N CHy \ o]
T
- cl \
O\S/O/ © HzN/ \0

HZN/ \\0
HCl is eliminated from the intermediate to generate
p-acetamidobenzenesulfonamide p-acetamidobenzenesulfonamide

The reaction is
a nucleophilic acyl substitution reaction.

e The amide is produced by treatment of the sulfonyl chloride with an
excess of aqueous ammonia.
NH,OH (ag) —NH; (aq) +H,0 (ag)
e NH3 is a good nucleophile
e Excess ammonia will neutralize the produced HCI by forming a salt
water soluble (NH,"CL") [acid base side reaction].
e Sulfuric acid is used to neutralize the excess ammonium hydroxide

and to decrease the solubility of our product and precipitate it.
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Procedure

Transfer the product obtained in experiment 2 (~10g); p-
Acetamidobenzenesulfonyl chloride to a 250 ml Erlenmyer flask.
Add 60 ml of conc. Ammonium hydroxide solution (28 %) and heat the

mixture on an 80 °C steam bath for 30 min. [a homogenous thick mixture

produced like past due to amide intermolecular H-bonding, and heating bcz the reaction is

endothermic]

Cool the mixture in an ice bath and add of sulfuric acid (6 M) dropwise
until it become acidic (pH 3-5). [add 2ml then drop by drop]

Cool the mixture again in an ice bath and collect the product by suction
filtration. [Cold Suction Filtration]

Wash the crystals with a small amount of cold water and dry them.

If necessary, recrystallize from a small amount of hot water.

Weight (gm) M.P

p-acetamidobenzene-sulfonamide

5

Brain storming Question

5.1 Discus the use of diluted ammonia instead of concentrated liquid.
3.2 Suggest other side reaction that could happen.
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Pre-lab.
Report sheet (7)

Synthesis of p_acetamidobenzene-sulfonamide

Student name:

Objectives:
Solidity
Compound (/mol) in Hazards
water
p-
Acetamidobenzenesulfonyl
chloride

Ammonium hydroxide

sulfuric acid

p_acetamidobenzene-
sulfonamide

Find out the melting point of p_acetamidobenzene-sulfonamide?

Draw a simple flowchart for the procedure of the exp. Or write an outline steps in
your own words?
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Post-lab.

Report sheet (7)

Synthesis of p_acetamidobenzene-sulfonamide

Student name:

1. Data and results:
The actual weight (yield) of p_acetamidobenzene-sulfonamide:

The theoretical weight (yield) of p_acetamidobenzene-sulfonamide (show
detailed calculation):

The yield%o:

2. Chemical equations:
Write down the balanced chemical equations that represent the
preparation of p_acetamidobenzene-sulfonamide:
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Experiment 8

Multistep Synthesis of Sulfanilamide
Part 4: Synthesis of sulfanilamide

NHCOCH;

NH;
Acid Hydroly5|s
1) H;0" / Heat
2) Na,CO,
Neutrallzatlon
4-acetamidobenzene

p-Aminobenzene

sulfonamide sulfonamide (Sulfanilamide)

e Sulfonamide group is slowly hydrolyzed and more stable in diluted
acid, due to:

I. steric hindrance to the approach of water molecules on
sulfur.

II.  Resonance stabilization, it is more resonance stabilized
than aceta-amide.

+
“\N/ \N/ "\ﬁ/
o~ | =0 o~ | =0 of'él o

e Carboxylic amide (aceta-amide) group hydrolyzes easily in very
diluted acid.

Amide and esters are easily hydrolyzed in both diluted acid or
diluted base condition with reflux.

¢ Neutralization with sodium carbonate (pH 6-7) in order to get the

free base and precipitate sulfanilamide.
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+ Sulfanilamide is amphoteric that has weak acidic and weak basic

properties.
pda ~
. @) N\
Basic ,"’/g40 \‘ Acidic
\ \ /
\\N H2/ /
+ OH- +-H30+
(base) (Acid)
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Mechanism

The reaction is
Hydrolysis reaction in diluted acid condition.

The mechanism involve proton transfer.

paceiamidabenzenesmjronamide

_aqueous HCI | ( \
Neas 3
\ GOH

/\\ /\\

The carbonyl of the amide reacts with
acid to activate the carbon toward nucleophilic

acyl substitution Water attacks the activated amide carbony! carbon io generate a
tetrahedral infermediate.

/H

(o)
NH 2 CH; \@ H —
@ 0

v/
S - \r

/
N\ X
\ TETRAHEDRAL INTERMEDIATE
The amino group is eliminated to \ | _

H

Z—m

generate sulfonamide and acetic acid

The tetrahedral intermediate transfers a proton

NH, o [from the oxygen to the nitrogen.

: A

\s +  HC OH
HZN/ \\0 sulfanilamide

Sulfanilamide in acidic condition will be protonated form of amine group, so
neutralization step to deprotonate it and get it free of charge to ppt.

.
NH;
f -2 —y HaNOsS

+ €03 + HCO3

HCOE + H30+ - COZ(g) T +H20
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Procedure

1. Weigh previous product (~5g) of p-Acetamidobenzenesulfonamide and
transfer it to a 100 ml round-bottomed flask.

2. Prepare a solution of dilute HCI by mixing equal volumes of conc. acid
and water.

3. Add to the amide an amount of dilute acid solution twice [in excess] the
weight of the amide. [excess to prevent drying during reflux]

4. Attach a reflux” condenser to the flask and heat at a gentle reflux for 30
minutes.

5. To the reaction mixture add equal quantity of water (equal to dil.acid added

before) and transfer the new mixture to a 600 ml beaker. [added water to
dilute the acid]
6. Neutralize the excess acid by the addition of small quantities of solid

sodium bicarbonate (Na2CO3) until the solution is just alkaline to

litmus paper (pH 6-7) and stope foaming. [added carbonate slowly to | foaming

and prevent loss of our product and avoid extra addition]

7. Cool the mixture in an ice bath and collect the crystals by suction
filtration. Wash the crystals with a small amount of cold water.

8. Recrystallize from small amount of hot water, decolorize the solution
with charcoal (if necessary) then collect the pure product and allow it

to dry in air.

Weight (gm) M.P

Sulfanilamide

6 Brain storming Question

6.1 Discus the reason behind using reflux.

6.2 Foaming will be resulted in this reaction, why?

6.3 Instep 5, discus the effect of excess carbonate (Na2COs) addition.

“ Please refer to appendix IV: Reflux and the reflux condenser. For more information.
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Pre-lab.

Report sheet (8)
Synthesis of sulfanilamide

Student name:

Objectives:

MW
Compound (e/mol) Hazards

p_
Acetamidobenzene
sulfonamide
HCI
sodium
bicarbonate
sulfanilamide

Find out the melting point of sulfanilamide?

Draw a simple flowchart for the procedure of the exp. Or write an outline steps in
your own words?
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Post-lab.

Report sheet (8)
Synthesis of sulfanilamide

Student name:

1. Data and results:
The actual weight (yield) of sulfanilamide:

The theoretical weight of sulfanilamide (show detailed calculation):

The yield%o:

2. Chemical equations:
Write down the balanced chemical equations that represent the
preparation of sulfanilamide:
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Experiment 9
Molecular modeling

In silico prediction of Ionization Constants of
Drugs

One of the basic tenets of medicinal chemistry is that biological activity is
dependent on the three-dimensional placement of specific functional
groups (the pharmacophore). Over the past few years, advances in the
development of new mathematical models which describe chemical
phenomena and development of more intuitive program interfaces coupled
with the availability of faster, smaller and affordable computer hardware
have provided experimental scientists with a new set of computational
tools. These tools are being successfully used, in conjunction with
traditional research techniques, to examine the structural properties of
existing compounds, develop and quantify a hypothesis which relates these
properties to observed activity and utilize these "rules"” to predict properties
and activities for new chemical entities. The development of molecular
modeling programs and their application in pharmaceutical research has
been formalized as a field of study known as computer assisted drug design
(CADD) or computer assisted molecular design (CAMD).

Molecular modeling allows scientists to use computers to visualize
molecules, to discover new lead compounds for drugs, or to refine existing
drugs in silico.

"Molecular modeling" is a term for which the definition has evolved along
with the capabilities of computer hard-ware and algorithms. The term
referred to software capable of displaying and manipulating simple

structures of molecules. As computer became faster and algorithms more



accurate, the term grew to include algorithms for calculating the structures
of small molecules

Modern molecular modeling software is used to study small molecules,
proteins, lipids, DNA, and non biological work.

One goal of molecular modeling is to develop a sufficiently accurate model
of the system so that the physical experiment may not be necessary.

Most pharmacologically active molecules contain one or more ionizing
groups, and it's well-known that knowledge of the ionization state of a
drug, indicated by the pKa value, is critical for understanding many
properties important to the drug discovery and development process.

The ionization state of a compound directly influences such important
pharmaceutical characteristics as aqueous solubility, permeability, crystal
structure, etc. Tremendous advances have been made in the field of
experimental determination of pKa, in terms of both quantity / speed and
quality /accuracy. However, there still remains a need for accurate in-silico
predictions of pKa both to estimate this parameter for virtual compounds

and to focus screening efforts of real compounds.

Methods of molecular modeling:

1. Quantum mechanics.
2. Molecular mechanics.

This experiment aims to teach you
How to convert 2-D structure in to 3-D structure?
How to find the most stable conformer for a given molecule?
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Conformation of cyclohexane

L7

chair

boat

> D

twist half chair

flagpole

axial
bowsprit
equatorial

The chair conformer is the most stable cyclohexane conformer

consists of 6 tetrahedral carbons bonded in a ring.

Bond angels are 109.50 with no angle strain.

No eclipsing C-H bonds and no torsional strain (all staggered).

The axial bonds looks like they eclipse, but the axial bonds are too
far away to contain torsional strain.

When all hydrogen atoms bonded (Cyclohexane), there is no steric
strain in the chair conformer.

Two chair forms in equilibrium

H

Boat , intermediate between chairs
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Software
Marvin software

Marvin is an advanced; Java based chemical editor for drawing chemical
structures, queries and reactions. It has pre-loaded structure templates. It is
capable of : 2-D to 3-D structural conversion ; 2-D cleaning and conformer
generation ; drawing and formatting shapes , arrows and text boxes ;

structure-based calculations ( e.g. charg log P, etc) .

The default layout of the MarvinSketch user interface is shown in the

following picture.

Brorvmskeren =S R Tp
File Edit \View Insert Atom Bond Structure QW&I;I
3 =y
H
c
N
o
o s
o, A
- L
= d
E o]
& L]
|
@1 S RONSNEIE, Advanced Templates |
MMl Status Bar |j§
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Opening and Saving a Molecule-File

To Open an Existing Molecule File

You can open existing molecule files (from supported file formats) by choosing File >
Open on the menu bar. It will load the content of the molecule file into Marvin and
discard any unsaved changes.

To Save a Molecule File

You can save the molecule to any of the supported file formats. This will allow you to
open and work with this molecule later. The default behavior of the Save button is to
save the molecule to the same file it was opened from, in the same format. If you want
to change the file name or format, choose Save As. If you are working with a new
molecule, Save will function the same as Save As.

To Save 'As Image'

The Save As Image choice in the File menu allows you to save an image of the
molecule in the sketcher.

General Toolbar

N . ows selection in rectangle mode on mouse drag.
Rectangle | Ajjous select tangle mod drag
Selection
&x Lasso. Allows selection in lasso mode on mouse drag.
Selection
- Structure Allows selection in structure selection mode on
() X mouse drag. With this selection mode only whole
Selection

fragments can be selected.

Erase Removes all structures upon selection.

Reverses the last command or the last entry you

é
Q Undo typed.
Q

edo Reverses the action of the last Undo command.

o Cut Removes and copies the selection to the clipboard.

L Copy Copies the selection to the clipboard.

e Inserts the contents of the clipboard at the location
- Paste

of the cursor, without replacing selection.

Checks and corrects chemical structures.

l% Check See Structure Checker in MarvinSketch for more
Structure :
details.
/‘g Zoom In Increases the canvas's magnification.
)‘9 Zoom Out Decreases the canvas's magnification.
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http://www.chemaxon.com/marvin/help/formats/formats.html
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http://www.chemaxon.com/marvin/help/sketch/gui/toolbars.html#select
http://www.chemaxon.com/marvin/help/sketch/gui/toolbars.html#erase
http://www.chemaxon.com/marvin/help/sketch/gui/toolbars.html#undo
http://www.chemaxon.com/marvin/help/sketch/gui/toolbars.html#redo
http://www.chemaxon.com/marvin/help/structurechecker/checker.html

100% | Zoom Tool

Changes the canvas's magnification to a specific
value. It can also do autoscale using named values:
All, Selection, Scaffold, R-groups.

Help Contents | Shows MarvinSketch User's Guide.

Tools Toolbar

l___] - Insert Bond Places various bond types on the canvas.
Places a carbon chain on the canvas. The number of
= . carbon atoms can be increased or decreased by
1= Insert Chain dragging the mouse. Selection of straight or curved
chain drawing is available.
b Thickens the selected bond. See details on bold
N Bold Tool .
- tool function.
| Hashed Bond | Makes the selected bond hashed. It only retains single
= Tool original bond type.
| T Insert Text Places a Te_xt object on the canvas. Allows changing
— text properties on the appearing toolbar.
Insert Reaction Places various reaction arrow objects on the canvas.
Arrow
l!];‘ Create Group Creates a custom abbreviation group.
[i T' B Insert Brackets Places brackets, parentheses, chevrons or braces on the
canvas.
Insert Graphics | Places various graphical objects on the canvas.
Increases the charge of the selected atom. The number
| of implicit hydrogens will be adjusted if possible to
[ + Increase Charge .
- accommodate the new charge. Valence errors will be
highlighted in red.
Decreases the charge of the selected atom. The number
m Decrease of implicit hydrogens will be adjusted if possible to
- Charge accommodate the new charge. Valence errors will be
highlighted in red.
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Atoms Toolbar

é Periodic System \?Vrilrc])(\;\gsw?eriodic system and query/atom property drawing
LH—‘ Insert Hydrogen | Places Hydrogen atom on the canvas.
[_(}— | Insert Carbon Places Carbon atom on the canvas.
u\l— | Insert Nitrogen | Places Nitrogen atom on the canvas.
[_0—' Insert Oxygen Places Oxygen atom on the canvas.
Ls—‘ Insert Sulfur Places Sulfur atom on the canvas.

[_F—' Insert Fluorine | Places Fluorine atom on the canvas.
LP— ‘ IIDnhsssTE)horus Places Phosphorus atom on the canvas.
L(él_' Insert Chlorine | Places Chlorine atom on the canvas.
[_BF! Insert Bromine | Places Bromine atom on the canvas.
[_I—‘ Insert lodine Places lodine atom on the canvas.

Chemical Toolbar

This toolbar contains chemical functions and it is not visible by default.

To make it visible, choose View > Toolbars > Chemical.
D Clean 2D | Calculates new 2D coordinates for the molecule.
Calculates new 3D coordinates for the molecule. Clean3D builds
up conformers of fragments from which the best, i.e. the lowest
Clean 3D | energy conformer is given back. The quality of the structures is
measured by a simple energy function (Dreiding type molecular
mechanics).
Convert
to Transforms the molecule to aromatic representation using the
Aromatic | transformation method set.
Form
Convert
to Kekulé | Transforms the molecule to non-aromatic representation.
Form
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Simple Templates Toolbar

If you only wish to use the 6 generic template structures without additional
functions, you can use the Simple Templates Toolbar. This toolbar is not visible by
default. To make it visible, choose View > Toolbars > Simple Templates.

& Cyclopentane (house)
02 Pyrrole

1O Cyclopentane

O Cyclohexane

| @ Benzene

o8 Naphthalene

Advanced Templates Toolbar

This  toolbar contains  special buttons holding structure  templates.
Additional functions of this toolbar:
1. The toolbar can show different template groups.

e General and My Templates:

DO O Oco|f 3 o & o

e Crown Ethers and Bridged Polycyclics:

- . = Fara ™ = 'oia TP (e T S g
[][}gyijraf‘ulc}'*c:{35‘-@@@‘%’
] [y - (o ] et SO S P L T

« To control which template sets are displayed on the toolbar, use the Properties panel
in the Template Library from insert menu:
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Template Library Manager

GG a v
[ Crown Ethers —| | Template Set Properties:
[Cy cycloalkanes g
“| Name: Heterocycles

[# Heterocycles

D Palycyclics
D Homology Groups

Location:

Settings:

fimarvin\ichemaxonimarnvin\templatesiheterocycles t

[] Display on Toolbar

[Cy alpha D sugars
D Beta D sugars

D Deoxynucleosides
[Cy Flavonoids

[ Nucleobases

[y Nucleosides

D Protoalkaloids

[7y True Alkaloids

[Ty vitamins

T4 My Templates

[ Templates l Properties

[v] Use molecules as templates at 2D cleaning

Checking the 'Use molecules as templates at 2D cleaning' checkbox will effect the
structures containing that template during cleaning of the structure: the default cleaning
form is overwritten by the template structure. This way, you can cutomize your
drawings: add or draw a set of templates and check this option.
Any structure can be added to the My Templates group.

Using
e

el Cut

2 Copy
Copy As...

{4 Delete

|[_EI Group. ..

&dd

Rernove

Link Mode

% Check Skructure

Transform

Format. ..

&dd ko My Templates

Pop-up

Ctd-x
CtH-Insert
Cto-k
Ct-G

F

]

F

]

Set the name of the new template.

menu

Right-click on the template icon on the template toolbar and

select Properties.
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o Set the name and/or the abbreviation of the template in the Template
Properties box.

o After that the template is identified with its name and/or abbreviation.

Q 0 @ i by
Cholesterol ()

Templates without a name

o If the template does not have a name, hovering the cursor over its icon
on the template toolbar magnifies the image on the icon. This improves
the visibility of the template icon, especially for big structures.

%ﬁ?{ r
O o mﬂe

The template can be removed from the toolbar.

« Right-click on the template icon and select Remove to remove the
template from the toolbar and from the My Templates list.

Status Bar of MarvinSketch

The Status Bar appears at the bottom of the main frame, and unlike toolbars, it cannot be customized or
moved.

The Status Bar consists of 3 parts:
2D * (2 (@NoProblems  Page: i@ @t B |pi| ofe
1. Dimension Button

Switches between 2D and 3D modes. If the current structure is
represented in 3D, then switching to 2D mode performs a 2D cleaning
upon confirmation.

2. File Status Indicator
This sign appears dynamically if there are unsaved modifications on the
current structure, and disappears upon a Save command.

-62-



3. Structure Checker Status
By default it is disabled as seen on the first image. To enable manual
checking double-click on it. Right-click enables automatic checking. The
status bar displays different images when there is no problem, if
checking is in progress or if problems were found.

4. Navigation Buttons
The Navigation Buttons appearing on the Status Bar dynamically using
multipage molecular documents provide a quick way to navigate
between pages.

Elemental Analysis

Basic molecular values related to the elemental composition of the molecule are
calculated by the Elemental Analysis.

In the Elemental Analysis Options panel you can check different properties:

Elemental Analysis Options x|

Type

Mass

Exact mass

Formula

Isotope formula
Dot-disconnected farmula
Dot-disconnected isotope formula
Composition

Isotope composition

Atom count

IUse D / T symbols for Deuterium / Tritium
[ ] Single fragment made

[QK ] [Eam:el ] [Eestore Defﬁultsi

e Type
e Mass: average molecular mass calculated from the standard atomic weights 2.

e Exact mass: monoisotopic mass calculated from the weights 2 of the most abundant natural
isotopes of the elements.

e Formula: chemical formula of the molecule according to the Hill system 2: the number of carbon
atoms is indicated first, the number of hydrogen atoms next, and then the number of all other
chemical elements subsequently, in alphabetical order. Isotopes (like Deuterium and Tritium) are
not listed separately but counted together (e.g., deuterium and tritium atoms are counted as
hydrogens). When the formula contains no carbon, all the elements, including hydrogen, are
listed alphabetically. If the molecule contains an SRU or Repeating Unit S-group, it will be taken
into account and Polymer Formula will be generated.
Note: For polymer structures, mass, composition, and atom count calculations are not available
and will return NaN, N/A, and -1, respectively.

e |sotope formula: chemical formula of the molecule listing isotopes separately according to the
Hill system.
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Dot-disconnected formula: chemical formula of the molecule(s) separating fragment formulas
by dots (e.g. salts, counterions, solvent molecules etc. are present).

Dot-disconnected isotope formula: chemical formula of the molecule separating fragment
formulas by dots and listing isotopes separately.

Composition: elemental composition given in weight percentage (w/w %) calculated from the
atomic masses.

Isotope composition: elemental composition listing isotopes separately (w/w %).

Atom count: number of all atoms in the molecule.

Use D/T symbols for deuterium/Tritium: if unchecked (default), isotopes of hydrogen are
displayed in formulas as 2H and 3H, if checked, D and T symbols are used.

Single fragment mode: if unchecked (default), the calculation handles unlinked molecules

together (e.g. salt molecules), summing up the masses of each component, if checked, the
results are displayed in a scroll window.

Name generator

[N MarvinSketch
File Edit View | Insert Atom Bond Structure Calculations Tools Help
N D C I ot | b Sl [] 2
L:1 - Q New Substituent HSC

Bond ]
- o , _ o o
l_:] Arrow ]
—1 Bracket ] /
L Electron Flow » — //\\b

; I8 0

l_?] Graphics 3
_—)] . |_ﬂ Text H
l[—]_1 2-formamido-3-(5-methylthiophen-2-yl)propanoic acid
(L1n
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Log P/log D

@A MarvinSketch 5.1.4 M=

File Edit Wiew Insert Atom Bond  Skructure - Help

X4 00 4WE T | @

SRR Prokonation ]
E Charge b logh:
| Isomers ]
E] Confarmation J

Geometry ]

Markush Enumer ation
Qther b

his(1 $I2-chlurulane]|; 4-amino-M-{3-methyl-1,2-oxazol-3-ylibenzene-1-sulfonamice

L LTDE

4]

UQPooow
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PKa

@ MarvinSketch 5.1.4

Edit

""" 4 00 ¥BE

File Wiewy

E'-

|4| PR

JO O 0

pKa Options

Decimal places

Acid/base prefix @

Min basic pka -10 |

Mode

Max acidic pka |20 |

Temperature (K} [z05 |

[¥] Show microspecies distribukion

Microspecies

pH loveer limit ||:| |

pH upper limik |14 |

pH step size [0,z |

[] Take major tautomeric Form

| Ik || Cancel || Restare Defaulks |

3

Insert  Atom Bond  Skructure

Tools

Help

Elemental Analysis
ILUPAC Mame

Protonation
Partitioning
Charge
Isarmers
Canfarmation
Geamekty

Markush Enumer ation

Qther

. . . .

k

Majar Microspecies

Isoelectric Poink
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Decimal places: setting the number of decimal places with which the result value is given.
e Mode: micro, macro: micro and macro acidic dissociation constants.
Acid/base prefix:

o static: submitted ionic forms are converted to their neutral forms (adding or removing protons)
and their pK. is calculated.

o dynamic: the pK, of ionic forms are calculated, not their conjugated acids or bases.

e Min basic pK.: widens the calculation range because weak bases will have lower pK. values than the
default -10.

e Max acidic pK.: widens the calculation range because weak acids will have higher pK. values than
the default 20.

e Temperature: setting the temperature in Kelvin.

Results are shown in a separate window

File Edit Wiew
18.00

pH %-1
0.00 100.00
020 100.00
0.40 100.00
0.60 100.00
0.0 100.00
1.00 100.00
1.20 100.00
1.40 100.00
1.60 100.00
1.80 100.00
2.00 100.00
220 100.00
2.40 100.00
260 100.00
280 100.00
200 Ann.nn
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2D and 3D Viewer Windows

Choosing View >Open 2D Viewer or Open 3D Viewer launches a MarvinView
window containing the current molecule of MarvinSketch

@ marvin.mryv - MarvinSketch 5.1.4

File Edit Eiew| Insert Atom Bond  Structure Tools  Help

}@ }e wen |w| (2

Transform

Zoanm

Display

Colors

Skeren

Implicit Hydrogens
Misc

Pages

v v v v v v v

[0 k= Periodic System,.. el

£ Open MarviniewzD

@ - < Open MarviniewaD
i@ Open MarvinSpace  Cte+Shifi-M

Toolbars [
L"'_] i Menubar Fi1

i Status Bar

|
L Canfigurations b

Custamize, ..
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B MarvinView
File Edit Yew Tools Pages Help

Isomers and their energies
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Conformers

Ex. Cyclopentane

@A MarvinSketch 5.1.4

File Edit Wiew Insert Atom Bond  Skructure - Help

[ (ed (U (S O (A (= (24T

N0 00 4BE

a

Kl

Boooow

Elemnental Analysis
ILPAC Marme
Probonation
Partitioning
Charge

Isomers

Geamekry
Markush Enumer ation

Qther

b
b
b
b

»

»

Molecular Dynamics
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Conformers Options E

Display options
im0 Display conformers

i Store conformer infarmation in properky Field

Energy unit kealfrmal -
Cpkimization limik Marmal -

[ |Ca||:u|ate lovwest energy: u:-:unF-:urmer|

Maxirurn number af canfarmers (10

Diversiky limit 0.1
Timnelimit () 200
[w] Prebydrogenize
[] Hyperfine
[] Wisualize H bonds
| (4 I | Cancel | | Restore Defaulks |

You can choose the option calculate the lowest energy conformer and just
the lowest energy conformer will be displayed

' Conformers

File Edit Yiew Table Tools Help
Corf: 1 Energy: 12.01 koalfmol Corf: 2 Energy: 15.98 koeal/mol

Select
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Stereoisomers(cis/trans)
EX. 2-pentene

@A MarvinSketch 5.1.4

- B

File Edit Wiew Insert Atom Bond  Structure

Tools | Help

x4 00 ¥ BE

Elemental Analysis

-
IUPAC Mame I b
Protonation ]
Partitioning ]
Charge [
I=omers F| Tautomers
Conformation ¥ Resonance
Geanmekry ¥| Skereaisomets

Markiush Enumeration
Qther

k

|4

Upooo

Stereoisomers Options E|

Generake

{1 ketrahedral stereo isomers|

im0 double bond stereo isarmers

i1 bath

[] Generate all sterenisomers

Generate maximum |1|:||:||:|

[ ] Filket irealid 30 struckures

| (0] || Cancel || Restore Defaulks
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@ Stereaisomers

File Edit Wiew Table Tools Help
1 2

HSC

CH,

Select

ITonization of compounds at different PH values and isoelectric point:
Ex, Oxazole

@ MarvinSketch 5.1.4

File Edit View Insert ftom Bond  Sktructure | Tools | Help
Elernental Analysis I 5 =
§ 00 KB © = 2 DBOE
ILP&AC Marne o
Protonation k| pka
Partitioning ¥| Major Microspecies
Charge ¥| Isoelectric Point
Isomers k
Confarmation b
Geornekry b
= - =
L | N Markush Enumeration
Jl Other 3
_] o}
=l
E

|4| SRR
o I BN
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Isoelectric Point Options

Decimal places

[¥#] Show charge distribution

pHstepsize 0.5 |

| (] 4 || Cancel || Restore Defaults |

@A Isoelectric Point
File  Edit

ho isoelectric point.

Mo L3 b3 BX R = OO
[ e e e e R e
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Major microspecies at specific PH value:

@ MarvinSketch 5.1.4 M=
Eile Edit Wiew Insert Atom Bond  Structure | Tools | Help
Elemental Analvsis -
IUPAC Mame [ & s T TR
Prokonation b pKa S
C
Partitioning ¥| Major Microspecies Iﬂ
Charge ¥ Isoelectric Poink !
s ' al
Isomets ] 2
Conformation [ @
iGeomekry ] j I
Markush Enumneration w 'L
Qther » @ I
=
L]

4]

S EEE:

2D *

(3] Major. Microspecies
pH=7.40

O

Oxazole not ionized at physiological Ph (7.4)
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Working with Multipage Molecular Documents
How to create a multipage molecular document

Multipage molecular documents help to work with large drawings by dividing them into pages. You can
create a multipage molecular document by choosing File > Document Settings..., then checking in

the Multipage document checkbox.

L3, Document Settings ﬂ

Document Header

Title: |Multipage |

Document Type
Multipage document|

Document Grid

Height: |5 pages

Width: |4 pages

Document Size

Page Size:

Margins (inches)

Left: 1.0 Right: |1

Top: 1.0 Batkam: (1.0

You can set the number of horizontal and vertical pages in the Document Grid part, and you can also
define the title, the page size and the margins in the corresponding sections of this dialog window. After
pushing the OK button, the following controls become automatically available:

The items in the View > Pages menu are enabled
A navigation status bar appears on the bottom of the window

The frame of the pages appear on the canvas, while the title, the margins and the page numbers are
displayed on each page
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EA MyMultipleMolecules.mrv - MarvinSketch -0l x|

File Edit | View | Insert Atom Bond Structure Calculations Tools Help
Transform b 100% - ?

i I;;;:;:; Zoom D ’% ’% .\-T nninnni
R , _.;
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Peptide Display ] |

D Misc PN, = @

@ Pages b = Fit Page Width @
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< Open MarvinView2D =

@ <% Open MarvinView3D 4 Previous Page B

@ . i Open MarvinSpace cul+shifia | ® NextPage @
Toolbars R ¥4 First Page

@ i [+ ﬂen;har Fi1 P1 Last Page @
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Explicit/implicit hydrogens
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Post-lab.

Report sheet (9)

Marvin software

Student name:

1. Draw the chemical structure of both cis- and trans-2butene, minimize them and
report their energies. Which of these isomers has the lowest energy? Can you
explain why?

2. Draw the structure of sulfamethoxazole .

3. Find the IUPAC name.

4. Calculate Log P value.

5. Do you think that the drug at physiological pH will be ionized or not (study the
degree of ionization of the drug at different pH's).

6. Draw the chemical structure of cyclohexane (determine the shape and energy of
the least conformer). Use the different visualization models.

7. Draw the chemical structure of cis- 1,2dimethylcyclohexane and trans-
1,2dimethylcyclohexane (compare between the energy of the two isomers).

8. Draw the chemical structure of the compounds provided by the instructor.
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Experiment 10
Molecular modeling

SAR analysis using accelrys software

Once the structure of a lead compound is known, the medicinal chemist
moves on to study its structure activity relationships (SAR).

The aim here is to discover which parts of the molecule are important to
biological activity and which are not. If it's possible to crystallize the target
with the drug bound to the binding site, the crystal structure of the complex
could be solved by x- ray crystallography, and then studied with molecular
modeling soft ware to identify important binding interactions. However,
this may not be possible, either because the target structure cannot be
crystallized or because the target structure has not been identified. If that
Is the case, it will be necessary to revert to the traditional method of
synthesizing a selected number of compounds that vary slightly from the
original structure, then studying what effect that has on the biological
activity.

In this lab, we will use the computer soft ware accelrys to study a protein
binding pocket and decide the most important forces that stabilize drug

protein complex.

Student must know
1. How to find binding pocket from the crystallographic image for
protein.
2. How to measure the distance between two atoms.
3. Requirements for each binding force to occur between enzyme and
inhibitor.
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The default layout of the accelrys DS visualizer user interface is shown in

the following picture.

m Accelrys DS Visualizer
File Edit  ‘iew Chemistry  Structure  Sequence  Scripks  Window  Help

Ed 9 Y XEADLB RS dma il AR P

Atom Display toolbar

The Atom Display toolbar contains buttons that allow you easy access to the commands
on the Atom tab of the Graphics View Display Style dialog.

Atom Display | Blanks selected atoms so they are not displayed on the

orf Off screen.

Line Displays atoms using a traditional wire frame display.
7 Nonbonded atoms are displayed as "jacks".

Stick Displays bonds using solid cylinders. Nonbonded
il atoms are displayed as "jacks" as in Line style.

Ball and Stick Depicts bonds using cylinders for bonds and balls for

Ls atoms.

Scaled Ball| Depicts bonds using cylinders and atoms using balls
. and Stick scaled to the van der Waals (VDW) radii.

Displays spheres sized to the van der Waals (VDW)

e |CPK radii.
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Sketching toolbar

The Sketching toolbar allows you to sketch structures directly in the 3D Window by
giving you access to tools to rotate torsions, to sketch atoms, chains, and rings, as well
as to add text to your structures.

P B b b e e

View toolbar

The View toolbar provides tools that manipulate the 3D Window or edit molecules in
the document.

R Select: Use the Select tool to select one or more objects using the mouse. Multiple
objects can be selected by clicking with the SHIFT key down on additional objects.

% Rotate: The Rotate tool is used to change the angle from which a molecule is
viewed.

“® Translate: The Translate tool is used to move a molecule in the plane of the
computer screen.

o L
= Zoom: The Zoom tool zooms the view in or out from a molecule.

fat Home: Undoes all rotations, returning the structure to the original orientation it

was in when it was imported or created. Note that centering - (Center Structure or
Fit To Screen) actions are not undone.

B Fit To Screen: Works in the same way as View | Fit To Screen.

Center Structure: Carries out the same operation as as View | Center.
Al Display Style: Accesses the same functionality as View | Display Style....

oo Measure: The Measure tool measures the distance, angle, or torsion between
selected objects.

To measure the distance between two atoms, deselect all objects, select two atoms or
one bond, and click the Measure tool. To measure the angle between three atoms,
deselect all objects, select three atoms or two connected bonds, and click the Measure
tool. To measure the torsion angle between four atoms, deselect all objects, select four
atoms, two disconnected bonds, or three connected bonds, and click the Measure tool.

N Display: The Display tool makes the object you click in either the 3D Structure
View or the Hierarchy View visible, and everything else invisible.
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Chemistry toolbar

The Chemistry toolbar provides shortcuts to commands in the Chemistry menu that
assist you in building molecules.

H Add Hydrogens Chemistry | Hydrogens | Add
() Hide Hydrogens Chemistry | Hydrogens | Hide
| Single Bond Chemistry | Bond | Single
Il Double Bond Chemistry | Bond | Double
It Aromatic Bond Chemistry | Bond | Aromatic
Il Triple Bond Chemistry | Bond | Triple
sl Periodic Table Chemistry | Element | Table...
Clean Geometry Structure | Clean Geometry

EX.
1. Open the DS visualizer.

2. From the toolbar, go to File-Open-protein data bank file-Captopril-ACE

complex.

Kl Accelrys DS Visualizer E]@

File  Edit  Wiesw Chemistry  Struckure  Seguence  Scripts Window  Help
Eld @ FD KEBEB

CRYSTAL STRUCTURE OF ANCE-CAPTOPRIL COMPLEX-probein data bank - 30 window >

g =Cel=
1] =*, CRYSTAL STRUCTI
2%F ProbeinSequen

WiNL

[#] == A

@ Hetatm

4 Prokein Group

!!!++++++++++
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To change the color of the background From the toolbar, under edit open
preferences then select 3D window from the left side (double click on
background color and choose the color you want).

To identify the binding pocket, from the cell window (on the left side): Open
the second A (click on +) then select captopril (code X8Z21615) .

From the toolbar, under Structure open Show by radius and enter the No. 10
then ok.

To differentiate between the amino acids in the binding pocket and the drug go

to View-Display Style and select stick model.

n] Accelrys DS Visualizer
File Edit ‘“iew Chemistry  Struckure  Sequence  Scripts Window  Help

e £ XLBHE

CRYSTAL STRUCTURE OF AMCE-CAPTOPRIL COMPLEX-protein data bank - 30 Window < ]

<

7 <Cell=
i ®=. CRYSTAL STRUCT

AEEEE = EEE

e ProteinSequen
=S

=D 0

¢ FBZIELS
[E] A¢ ZNiELE
[ A¢ HAGLE17
[ A¢ HAGLELE
[] A EBMalels
[ A BMalezo
[ A¢ Manie2z1
[ A¢ WaGiszz
[ A¢ NAGiE2S
[ A¢ Man1624

&5 Water *

@ Hetatm *

& Protein Group

| >

7.

Try to identify the Zn atom and identify how the drug is strongly attached to
the metal atom in the binding pocket.

To find hydrogen bonding interactions between drug and the enzyme: select
captopril (as shown above) then go to Structure Monitor —intermolecular
H-Bond) .
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E Accelrys DS Visualizer
File Edit  ‘Wiew  Chemiskry  Struckure  Sequence  Scripts wWindow  Help

Edd P XIBA

|7 CRYSTAL STRUCTURE OF ANCE-CAPTOPRIL COMPLEX-protein data bank - 30 Window ]

A <iell=
1] w*, CRYSTAL STRUCTI
gfEE ProteinSequen
=D A
= A
A REZ161S
[B] ¢ 2HiBls
[] A¢ NaG1EL7
[ A¢ NaGiela
[ ¢ BMALELD
[] ,A¢ EMALEZD
[ A¢ Manis21
[ A¢ HaGtezz
[] A¢ NaGiezs
[ A¢ Mania24
& Water
@ Hetatm
£ Protein Group
¥ HBond Manitor1

A28 EsEeEEE

9. To identify the amino acids in the binding pocket that have interactions with

the ligand ,select the amino acid then right click and choose label

Akkribuke

s 3

Cuskom Eexk {M
| |

Faonk Calor

\arial v| 10 v IIII

Choose amino acid from_object and name from attribute then apply and ok
and the abbreviated name of the amino acid will appear.

Or from the cell window open H bond monitor 1(click on +) and all h-bond
details will appear.
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10. Fill the drug enzyme interaction tables listed below:

No

Drug Functional
Group

Amino acid

Type of
interaction
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Pre-lab.

Report sheet (10)
SAR analysis using accelrys software

Student name:

Draw the structures of the 20 standard amino acids and classify them?

Draw the structure of captopril then find out the ITUPAC name?

Draw the structure of levothyroxine then find out the ITUPAC name?



Post-lab.

Report sheet (10)
SAR analysis using accelrys software

Student name:

Procedure

1. Open the DS visualizer.

2. From the toolbar, go to File-Open-protein data bank file-thyroxine
thyroid hormone receptor interactions.

3. To identify the binding pocket, from the cell window (on the left
side): Open the second X (click on + ) then select thyroxine (code
T44500).

4. From the toolbar, under Structure open Show by radius and enter the
No. 10 then ok .

5. To differentiate between the amino acids in the binding pocket and
the drug go to View-Display Style and select stick model .

6. To find hydrogen bonding interactions between drug and the
receptor: select thyroxine (as shown above) then go to Structure
Monitor —intermolecular H-Bond ) .

7. Fill the drug enzyme interaction tables listed below.

Ao Amino acid Drug Functional type of

Group interaction
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Appendix |

Percent Yields Calculations

Many synthesis require more than one reaction, with each reaction yielding
an isolated compound before the final product is reached. Each individual
step in the sequence has a percent yield, and the total synthesis has an
overall yield calculated from the steps yields

e Limiting reagent :
the reagent that is present in the smallest equivalent stoichiometric
amount and limits how much product will be produced. It
determines the maximum amount of product(theoretical yield) that
will be formed.

actual mass yield

*100%

e Percentyield =
y theoretical yield

% yield for step 1 , % yield for step 2 N % yield for step 3
100 100 100

e Overall yield =

Each individual step has a relatively high efficiency, but the overall
efficiency is low. Each subsequent reaction further reduces the actual
amount of product that is formed from the initial starting material.
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Example (1) from cycle 1:

EXxcess EXCESS EXxcess

NHCOCH3 / oot NHCOCH,

\UI OH
CISO;H 1) Hy0™ / Heat /
llu[
2) Na,CO;
Clo,s

HaNO,S HaNO,S

Acetanilide p-acetaminobenzene p-acetaminobenzene sulfanilamide
sulfonylchloride sulfonamide

1. You have 3 steps for this reaction, so you have to find percent yield for
each step then multiply them to find the overall yield for the synthesis.

2. In this cycle the other reactants were used in excess so your main
reactant will be the rate limiting reactant.

For Step 1:

Acetanilide + chlorosulfonic acid > p acetaminobenzenesulfonylchloride

*Amount used 15¢g excess

*No.of moles  (15/135.17) excess(no need to calculate)
(wt/m.wt)

(0.111 moles) excess

So rate limiting reactant is acetanilide
No. of moles of product =No. of moles of acetanilide (ratio 1:1) =0.111
moles Theoretical yield = 0.111*233.67(m.wt of product) = 25.93 g

actual mass yield

% vield = * 100%

theoretical yield

Let’s assume that when you weighed your product after drying in the next
lab and was 16 g (this 16 g is your actual yield)

So % yield for this step is equal to (16/25.93) *100% = 61.7%

** Make the same calculations for the second two steps , then multiply
them to find the overall yield.
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Example (2): (if the reactant not in excess)

Calculate the % yield if 2 ml of benzaldehyde(density =1.043, m.wt
=106) were reacted with 4 ml of phenylhydrazine ((density =1.095,
m.wt=108) in order to synthesize phenylhydrazone (m.wt=196)

Benzaldehyde 4 p-nitrophenylhydrazine Benzaldehyde 4-nitro
phenyl hydrazone

a. Convert volumes to no. of moles
- weight 2*1.043 4*1.095
(vol*density) =2.080 =4.38

#moles 2.080/106 4.38/108
(wt/m.wt) =0.019 =0.04

Ratios to find rate limiting reactant:
1 mol of benz. 1 mol of hydrazone
0.019 mole ?
= 0.019moles of hydrazine(product)

1 mol of hydrazine 1 mol of hydrazone
0.04 mole 9

= 0.04moles of hydrazine(product)
So benz. Is the rate limiting reactant(lower no. of moles of product).

so no. of moles of product =0.019 moles
Theoretical yield = 0.019 *196(m.wt of product)= 3.72g

Assume that you weighed your product and was
equal to 29 So
%yield = 2/3.72 *100% =53.76%
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Appendix Il

Melting Point Measurement

A melting point is:

The temperature at which the first crystal just starts to melt until the temperature at
which the last crystal just disappears. Thus the melting point (abbreviated M.P.) is
actually a melting range. You should report it as such, even though it is called a melting
point, for example, M.P. 147-149°C.

e It requires that the intermolecular forces that hold the solid together have to be
overcome, the temperature at which melting occurs will depend on the structure
of the molecule involved.

e A pure, nonionic, crystalline organic compound usually has a sharp and
characteristic melting point (usually 0.5-1.0 C range).

e A mixture of very small amounts of miscible impurities will produce a
depression of the melting point and an increase in the melting point range.

Generally, melting points are taken for two reasons.

1. Determination of purity.
If you take a melting point of your compound and it starts melting at 60 °C and
doesn’t finish until 180 °G you might suspect something is wrong. A melting
range greater than 2°C usually indicates an impure compound (As with all rules,
there are exceptions. There aren’t many to this one, though.).

2. ldentification of unknowns.

a. If you have an unknown solid, take a melting point. Many books (ask
your instructor) contain tables of melting points and lists of compounds
that may have a particular melting point. One of them may be your
unknown. You may have 123 compounds to choose from. A little
difficult, but that’s not all the compounds in the world. Who knows??
Give it a try. If nothing else, you know the melting point.

b. Take your unknown and mix it thoroughly with some chemical you
think might be your unknown. You might not get a sample of it, but you
can ask. Shows you know something. Then:

i.  If the mixture melts at a lower temperature, over a broad
range, your unknown is NOT the same compound.

ii.  If the mixture melts at the same temperature, same range,
it’s a good bet it’s the same compound. Try another one,
though, with a different ratio of your unknown and this
compound just to be sure. A lower melting point with a sharp
range would be a special point called a eutectic mixture, and
you, with all the other troubles in lab, just might accidentally
hit it. On lab quizzes, this is called
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“Taking a mixed melting point.”

Actually, “taking a mixture melting point,” the melting
point of a mixture, is more correct. But | have seen this
expressed both ways.

Sample preparation

Sample preparation:

You usually take melting points in thin, closed end tubes called capillary
tubes. They are also called melting point tubes or even melting point capillaries.
The terms are interchangeable, and I’ll use all three.

Sometimes you may get a supply of tubes that are open on both ends! You
don’t just use these as is. Light a burner, and close off one end, before you start.
Otherwise your sample will fall out of the tube (see “Closing Off Melting Point
Tubes,” following).

Take melting points on dry, solid substances ONLY, never on liquids or
solutions of solids in liquids or on wet or even damp solids.

Only on dry solids!

To help dry damp solids, place the damp solid on a piece of filter paper and
fold the paper around the solid. Press. Repeat until the paper doesn’t get wet.
Yes, you may have to use fresh pieces of paper. Try not to get filter paper fibers
in the sample, OK?

Occasionally, you may be tempted to dry solid samples in an oven. Don’t—
unless you are specifically instructed to. I know some students who have
decomposed their products in ovens and under heat lamps. With the time they
save quickly decomposing their product, they can repeat the entire experiment.

Loading the Melting Point Tube

Place a small amount of dry solid on a new filter paper (Fig. 1). Thrust the
open end of the capillary tube into the middle of the pile of material. Some solid
should be trapped in the tube. Turn the tube over, closed end down. Remove
any solid sticking to the outside. The solid must now be packed down.
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'Life-size’” M.P. tube
with packed sample

Open end of M.P, tube
/ Compound forced

l t Sample ' into tube {You gan see it melt)

& =12mmof
packed solid

Figurel . Loading a melting point tube.

e Traditionally, the capillary tube, turned upright with the open end up, is
stroked with a file, or tapped on the bench top. Unless done carefully, these
operations may break the tube. A safer method is to drop the tube closed end
down, through a length of glass tubing. You can even use your condenser or
distilling column for this purpose. When the capillary strikes the bench top, the
compound will be forced into the closed end. You may have to do this several
times. If there is not enough material in the M.P. tube, thrust the open end of the
tube into the mound of material and pack it down again. Use your own
judgment; consult your instructor.

e Use the smallest amount of material that can be seen to melt

Closing Off Melting Point Tubes

If you have melting point tubes that are open at both ends and you try to take
a melting point with one, it should come as no surprise when your compound
falls out of the tube. You’ll have to close off one end, to keep your sample from
falling out (Fig.2). So light a burner and get a “stiff” small blue flame. SLOWLY
touch the end of the tube to the side of the flame, and hold it there. You should
get a yellow sodium flame, and the tube will close up. There is no need to rotate
the tube. And remember, touch— just touch—the edge of the flame, and hold
the tube there. Don’t feel you have to push the tube way into the flame.
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Figure2 . Closing off a M. P. tube with a flame.

Melting point hints:

1. Use only the smallest amount that you can see melt. Larger samples will heat
unevenly.

2. Pack down the material as much as you can. Left loose, the stuff will heat
unevenly.

3. Never remelt any sample. They may undergo nasty chemical changes such as
oxidation, rearrangement and decomposition.

4. Make up more than one sample. One is easy, two is easier. If something goes
wrong with one, you have another. Duplicate, even triplicate runs are common.

Never repeat melting point’s measurement with the same capillary as most of
organic compounds decompose or react in other ways upon heating. This
resulted in new materials with new melting points.
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Appendix 111

Recrystallization and filtration techniques

+ Part I: Recrystallization (or Crystallization):

Is a technique used to purify solids. This procedure relies on the fact that solubility
increases as temperature increases (you can dissolve more sugar in hot water than in
cold water). As a hot, saturated solution cools, it becomes supersaturated and the
solute precipitates (crystallizes) out.

In a recrystallization procedure, an impure (crude) solid is dissolved in a hot solvent.
As this solution is cooled, the pure product crystallizes out and the impurities
stay dissolved.

v As the compound crystallizes from the solution, the molecules of the other
compounds dissolved in solution are excluded from the growing crystal
lattice, giving a pure solid.

v Crystallization of a solid is not the same as precipitation of a solid.

v" Incrystallization, there is a slow, selective formation of the crystal framework
resulting in a pure compound.

v In precipitation, there is a rapid formation of a solid from a solution that
usually produces an amorphous solid, containing many trapped impurities
within the solid's crystal framework.

Crystalline Amorphous
OO0
CLX XX X XD

XXX )
“‘...

Hot gravity filtration

Add hot solvent @
removes solid b
—

Cool solvent
E—

Vacuum filtration
e

aaaaaa
aaaaaa
aaaaaa

aaabaaba
aabbaaaab
aaaaabaaa

impure solid a dissolves, b does not purified solid

When impurities are less soluble
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‘acuum filtration
—

c c

aaaaaa

purified solid

When impurities are more soluble

General Recrystallization Procedure:

1) Choose an appropriate solvent(s)

* product is very soluble in it at high temperatures (boiling point of solvent)

* product is not soluble in it at low temperatures (only sparingly soluble in the
solvent at room temperature

« impurities are either soluble at all temps or insoluble at all temps (can be filtered
off)

« The solvent should not react with the compound being purified

« The solvent should be volatile enough to be easily removed from the solvent
after the compound has crystallized.

2) Dissolve impure solid
+ weigh out crude solid and record its mass (also take a melting point for
reference)
+ add a boiling chip or boiling stick (otherwise, it may "bump" and spill)
* use a minimum amount of hot solvent (Add a bit, heat/swirl. Not
dissolved? Add more!) NOTE: IF YOU USE TOO MUCH
SOLVENT, YOU WILL GET NO CRYSTALS!

3) ONLY IF NEEDED: Decolorize
» most pure compounds are white and give colorless solutions (looks like water)
« to remove color (really trace contaminants), add activated charcoal (adsorbs
the impurities)

4) ONLY IF NEEDED: Gravity filter to remove insoluble materials (including
charcoal!)
« use fluted filter paper and a hot, stemless funnel
NOTE: IF THE SOLUTION COOLS, PRODUCT WILL CRYSTALLIZE OUT
& BE LOST!
« use a small amount of hot solvent to rinse flask, filter

5) Crystallize solute (Finally! This is the RECRYSTALLIZATION part!)
+ cool the solution slowly: hot (boiling) — room temperature — 0 °C
(put in ice water bath) NOTE: THIS GIVES LARGE, PURE
CRYSTALS & LEAVES IMPURITIES IN SOLUTION
* may need to scratch glass with a stirring rod or add a seed crystal to start
crystallization

6) Collect the pure crystals
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« quickest method is vacuum filtration (Blchner funnel, water aspirator and trap)

« the impurities will stay dissolved in the solvent that is being removed
(hopefully)

* rinse the pure crystals with a small amount of cold solvent (don't redissolve the
crystals!)

* OPTIONAL: a second crop of crystals can be obtained from the filtrate
(mother liquor)

7) Analyze product
* let crystals dry thoroughly (ideally, this means overnight at room temperature
or under vacuum)
« record mass (how much of your original solid did you recover? % recovery?)
« record melting point range (did you succeed in PURIFYING your solid?)

Mixed solvent recrystallization:

When no single solvent can be found that meets all of the criteria for
crystallization, it may be possible to use a mixed solvent. A pair of solvents is
chosen: one in which the compound is soluble (called the "soluble solvent™), and
one in which the compound is insoluble (called the "insoluble solvent™). The two
solvents must be miscible in one another so that their solubility with one another
does not limit the proportions used. Ethanol/water, methanol/water and
acetone/water are common mixed solvents used in crystallization.

To perform a crystallization using a mixed solvent, the solid to be crystallized
is first dissolved in the minimum amount of hot "soluble solvent”, then hot
"insoluble solvent" is added dropwise until the solution becomes slightly cloudy.
An additional small portion of hot soluble solvent is then added to clarify the
solution, and the solution is set aside to slowly cool and crystallize. A diagram
describing this process is shown in the following Figure.

soluble "Sotuble
solvent" lvent"
: =

Add "insoluble
solvent" dropwise
until cloudy

Add "soluble
solvent" to
clarify

Add minimum
amount of hot
"soluble solvent"

=

Sy,

dissolved cloudy dissolved

Schematic for using a mixed solvent in crystallization.

+ Part |1: filtration techniques

A. Gravity Filtration:

Is simply putting a funnel with filter paper over a flask, pouring a liquid/solid mixture
into the funnel and allowing the liquid to drip into the flask by gravity. The liquid
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and any dissolved substances pass through while the solid stays behind on the filter
paper (think of a drip coffee maker).

e The filter paper used in gravity filtration is a cone made by folding a round of
filter paper in four and opening one leaf. Fluted filter paper works faster and
can be made by folding the cone multiple times and opening it like a fan. In
both cases the filter paper should be the same size as the funnel being used.

B. Hot gravity filtration

A variation of this technique is hot gravity filtration in which the entire setup is
kept warm during the filtration process. Hot gravity filtration is needed when the
desired product is soluble in hot solvent, but precipitates in cool solvent. If the
solution cools during filtration, the desired product will precipitate and get trapped
on the filter paper along with the insoluble impurities.

e To set up a hot gravity filtration, put an Erlenmeyer flask on a warm hotplate
then lower a stemless funnel, stabilized with a ring support, until it sits on
top of the flask. A stemless funnel is used because crystals can form in the
cool stem of a long-stem funnel and clog it. It is important that the glass setup
is warm before starting the filtration. When most of the solvent has gone
though the funnel, the filter paper is washed with a few mLs of fresh, hot
solvent and the setup is allowed to cool.

funnel
Ring support

Erlenmeyer flask

‘ Hot Plate

Hot gravity filtration
C. Vacuum Filtration (Suction filtration)

Vacuum or filter flasks look like Erlenmeyer flasks, but with a side arm for
attachment to a vacuum line. To set up a vacuum filtration, clamp a filter
flask to a ring stand. Connect a thick-walled vacuum hose to the side arm and
to the vacuum outlet. Don’t use a flimsy water hose — it will collapse under
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vacuum pressure. Place a rubber adapter on top of the flask, followed by a
Buchner funnel. The rubber adapter forms an air-tight seal between the funnel
and the flask — do not attempt the filtration without it. Find a piece of filter
paper that fits flatly in the Buchner funnel, covering all the holes, but not
coming up the sides. This setup is top heavy and will tip over — use a clamp
on the filter flask.

Buchner Funnel

Rubber Adapter

To Vacuum line
—

Filter Flask

Vacuum Filtration
(Suction filtration)

When you are ready to filter, turn on the vacuum, wet the filter paper with a
little of the solvent you recrystallized from.

— only use water if you recrystallized from water! — and pour the contents of
the recrystallization flask into the Buchner funnel. Just before pouring, swirl
the flask to get the crystals in suspension. Pour fast enough so that the crystals
get into funnel instead of getting stuck on the sides of the flask. If crystals get
stuck in the flask, you may rinse with no more than 5 mLs of cold solvent.
Pull air through the filter for several minutes to help dry the crystals. If
recrystallizing from water, put the filter paper with all the crystals on it in a
provided envelope to dry until the next laboratory period. If recrystallizing
from an organic solvent (which generally have lower boiling points and dry
faster), it is usually ok to take a melting point the same lab period. We never
use vacuum filtration for low boiling solvents like ethyl ether or low boiling
products. A vacuum is a reduced pressure environment. Low boiling solvents
boil even lower at low pressure and will vaporize and get pulled into the
vacuum line.
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Appendix IV

Reflux and the reflux condenser

Reflux is a chemistry lab technique that heats a solution, produces vapor, and
then condenses and returns the outgoing vapor into its original mixtures.
Reflux is widely used in undergraduate organic chemistry labs.

i

Purposes: —
* to reduce the loss of solvent

through evaporation
» Complete the reaction in a ...._
reasonable time

Basic Setup:

1. Place the reagents in a round-bottomed flask.
The flask should be large enough to hold both the reagents and enough solvent
to dissolve them, without being much more than half full.

2. You should now choose a solvent that
a. Dissolves the reactants at the boiling temperature.
b. Does not react with the reagents.
c. Boils at a temperature that is high enough to cause the desired reaction to
go at a rapid pace.

3. Dissolve the reactants in the solvent.
Sometimes the solvent itself is a reactant. Then don’t worry.

4. Place a condenser, upright, on the flask, connect the condenser to the water faucet,
and run water through the condenser (Fig. 83). Remember —in at the bottom and
out at the top.

5. Put a suitable heat source under the flask and adjust the heat so that the solvent
condenses no higher than halfway up the condenser. You’ll have to stick around
and watch for a while, since this may take some time to get started. Once the
reaction is stable, though, go do something else. You’ll be ahead of the game for
the rest of the lab.

6. Once this is going well, leave it alone until the reaction time is up. If it’s an
overnight reflux, wire the water hoses on so they don’t blow off when you’re not
there.

Always makes sure the hoses are securely attached to the condenser.
A gentle flow of cooling water is all that is needed.
Check for leaks!
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Appendix V

Boiling chips
Boiling chips:

Are small, insoluble, porous stones made of calcium carbonate or silicon carbide.
These stones have pores inside which provide cavities both to trap air and to provide
spaces where bubbles of solvent vapor can form. These bubbles ensure even boiling
and prevent bumping and boiling over and loss of the solution.

» Always use a boiling chip when heating a solvent.

» Never add a boiling chip to a solvent which is already hot, because it can
cause to solvent to boil over violently.

« If you forget to add a boiling chip before you begin, you must cool the
solution before adding one to prevent product loss.

« Boiling chips cannot be re-used since the pores inside these stones become
filled with liquid on cooling.

It should be placed in the distillation flask for two reasons:
1. they will prevent superheating of the liquid being distilled

2. they will cause a more controlled boil, eliminating the possibility that the liquid
in the distillation flask will bump into the condenser
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Appendix VI

Other suggested mechanism for Step2 in cycle 1

Step 1: Chlorosulfonic acid undergoes dimerization to generate the electrophilic
reagent used to react with acetanilide

Chiorosulfonic Acid
| 7O\ I
C1—|S|—0H Cl—ﬁ—OH —ﬁ—07s\ O
) 0 (a ( (8]
Chlorasulfonic acid reacts with itself l
to form a "dimeric” chlorosulfonic 0
This anlydride is the electrophilic "
recgent in the electrophilic aromatic substitution
reaction with acefanilide. Cl—ﬁ—o—ﬁ—OH
0
Chiorosuifonic anhydride

Step 2: Chlorosulfonic anhydride reacts with acetanilide via and electrophil ic
aromatic substitution to generate p-acetamidobenzenesulfonylchloride.

Acetanilide
; H
™ CH;
. \ﬂ/
0\\ o
8
I s
0'?‘\\01
VARYL
00—
/>
0
1 HO
OH l
One aof the pi bonds of the aromatic ving
veacts with the electrophilic sulfur atom of H
the chlovosulfonic anhydride. The pi bond of the
that reacts is g-ne that places the sulfonyl c}ilu{fde g’?\f;p + O
para fo the amide group aiready on the ring. The amide group is N CHsy /
an activating, o-/p-directing group Q=—%§ 2
As the pi electronsof the ring react with the o / \0
sulfir atom, the S=0 pi bond breaks to place \ O HO
afamaidm’lﬁizrheomn The non-reacting \S
the, takes formal ch +1.
of thepi on a formal charge of CI/\\ Sulfiric acid
o}
pac b Ifony! chloride

Iﬁssiemmmthenegaﬁwbvdaargsdmgen then shift back in to reform the S=0 pi bond and
Kok our bisulfate. Concirrently, a H atom of the ring gives up its electrons to reform the pit bond

of the ving to restore aromariclty. Sulfuric acid is formed as a by-produet.
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Appendix VII
Extraction

% Extraction Theory:

When a solution is placed in a separatory funnel and shaken with an immiscible solvent,
solutes often dissolve in part into both layers. The components are said to "partition™
between the two layers, or "distribute themselves" between the two layers. When
equilibrium has established, the ratio of concentration of solute in each layer is constant
for each system, and this can be represented by a value KK (called the partition
coefficient or distribution coefficient).

Molarity in organic phase

- Molarity in aqueous phase

For example, morphine has a partition coefficient of roughly 6 in ethyl acetate and
water.22 If dark circles represent morphine molecules, 1.00g1.00g of morphine would
distribute itself .

® ® ]

25 mL I:lhy

o ®__

CH,

N
sl 50 mL Ethyl
\ acetate

acetate

HO

) =
H OH 50 mL

Morphine = ® Water Water
_ lMorph-ine]e(hyl acetate = 0.0600 M o K= 0.105M _ £93
[Morphine]aer =0.0101 M 0.0177M

Distribution of morphine in ethyl acetate and water.

Note that with equal volumes of organic and aqueous phases, the partition
coefficient represents the ratio of particles in each layer. When using equal volumes,
a K of ~6 means there will be six times as many morphine molecules in the organic
layer as there are in the water layer. The particulate ratio is not as simple when the layer
volumes are different, but the ratio of concentrations always equals the K.

The partition coefficients reflect the solubility of a compound in the organic and
aqueous layers, and so is dependent on the solvent system used. For example, morphine
has a K of roughly 2 in petroleum ether and water, and a K of roughly 0.33 in diethyl
ether and water. When the K is less than one, it means the compound partitions into the
aqueous layer more than the organic layer.
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% Quantitating Single Extraction

4~ Add 150
mL ether

Single extraction of hyoscyamine (K~4) from water into diethyl ether.
[0.5090.50g hyoscyamine in 150mL150mL water is to be extracted into 150mL150mL diethyl ether]

organic solubility

aqueous solubility

_ (1.44g hyoscyamine/100mL diethyl ether)
B (0.354g hyoscyamine/100mL water) B

~4.07

If " x " is the gram quantity of hyoscyamine extracted into the diethyl ether layer, then
" 0.50g—x " would remain in the aqueous layer after equilibrium is established.
Knowing the value of K, the value of x can be solved for using the equation below.

_ (x/100mL diethyl ether)
~ (0.5—x)/100mL water)

~4.07

X=0.4g

0,

% Multiple Extractions

Overview of Multiple Extractions:

Depending on the partition coefficient for a compound in a solvent, a single
extraction may be all that is needed to effectively extract a compound. However, more
often than not a procedure calls for a solution to be extracted multiple times in order to
isolate a desired compound, as this method is more efficient than a single extraction.

In a multiple extraction procedure, a quantity of solvent is used to extract one layer
(often the aqueous layer) multiple times in succession. The extraction is repeated two
to three times, or perhaps more times if the compound has a low partition coefficient in
the organic solvent.
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@ First extraction: @ Second extraction:

4~ Add ether / 4\ Add fresh
2 ether
\ J \ Aqueous L_( | \ —
P ) L J S from Ist _~ J (N P ~
V4 N Y4 \\ ( / A\ extraction // \] / A\ / \\)
( ) ((mmmm=- N ) ( (mommmad) ( )
\ /" Eer\ 7 Stakeand \ / \ | B\ ————  Shakeand \ y
\ _____ / ner o === ./ separate layers \ / \ / e\ — e / separate layers '\ /
— = \\\_,"/ / \ / (= e/ =3 \ /
/ \ /
Aqueous \ Aqueous \ / \\ /4 \ / Aqueous\ / \ /
\ \ \ /
\¥/ \/ LY ! °/ L
S s ;]D/ = oo =
| = | =
Py p—
eomns) [
Ether Aqueous Ether Aqueous

I combine organic layers |

Multiple Extractions of an aqueous layer when the organic layer is on the top:
a) First extraction, b) Second extraction.

In a multiple extraction of an aqueous layer, the first extraction is procedurally
identical to a single extraction. In the second extraction, the aqueous layer from the first
extraction is returned to the separatory funnel, with the goal of extracting additional
compound. Since the organic layer from the first extraction had already reached
equilibrium with the aqueous layer, it would do little good to return it to the separatory
funnel and expose it to the aqueous layer again. Instead, fresh diethyl ether is added to
the aqueous layer, since it has the potential to extract more compound.

The process is often repeated with a third extraction, with the aqueous layer from
the second extraction being returned to the separatory funnel, followed by another
portion of fresh organic solvent. In multiple extractions, the organic layers are
combined together, as the goal is to extract the compound into the organic solvent.

@ First extraction: @ Second extraction:

#~Add 25 mL #~ Add 25 mL
CH,Cl, fresh CH,Cl,

Y @m A ma onm
< / 50,,d(' """ ) Shake and ( ) ‘\ > Aq“eo“g- ----- / Shake and /\ />

drainbottom \ ~emwe./ O\ oo = drain bottom  \ ——=o.
----- Aqueous 3 £ =) © \\
. ——) \—
CH,Cl, Aqueous\

g = et/ — e o
50 mL 25mL ‘—’/ }

Aqueous / CH,Cl / Aqueous " Aqueous ! / 7 \
“}Z?]D ﬂlﬁﬂ@ %élD ﬁﬂ@ h;UD -0
/ ¥

combine organic layers

CH,Cl, CH,Cl,
Multiple Extractions of an aqueous layer when the organic layer is on the bottom:
a) First extraction, b) Second extraction.
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% Quantitating Multiple Extraction

a) First extraction: b) Second extraction: ¢) Third extraction:

Add et m o~ Add fresh m o~ Add fresh
~ ether

ether ether

Aqueous Ether

Aqueous Ether

Multiple Extractions of hyoscyamine (K~4) from water into diethyl ether.
[0.50g hyoscyamine in 150mL water is to be extracted into three 50mLportions of diethyl ether].

g = Z/1oomLdiethylether) _ 4 47 . First Extract
(0.5—x)/100mL water)

100mL diethyl eth
— (x/100mL diethylether) _ 4 o7 second Extract
(0.21-x)/100mL water)

(x/100mL diethyl ether)
(0.09—x)/100mL water) -

K = ~4.07 ..... Third extract

Ether Ether Ether Combined Ether
Extracts

If the 50mL diethyl ether extracts are combined in this example, there would be a
total of 0.46g of hyoscyamine in the combined organic extracts. Of the 0.50g of
hyoscyamine in the original aqueous layer, 92% of the material is extracted into the

. o 0.46g
organic layer (100% X 0508

extraction of 150mLdiethyl ether, which resulted in only 0.40g of hyoscyamine
extracted (80%b).

). This is a greater quantity than was obtained using a single
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Appendix VIII

Benzoin condensation using cyanide

The reaction is catalyzed by nucleophiles such as a cyanide or an N-heterocyclic
carbene (usually thiazolium salts). The reaction mechanism was proposed in 1903
by A. J. Lapworth. In the first step in this reaction, the cyanide anion (as sodium
cyanide) reacts with the aldehyde in a nucleophilic addition. Rearrangement of the
intermediate results in polarity reversal of the carbonyl group, which then adds to the
second carbonyl group in a second nucleophilic addition. Proton transfer and
elimination of the cyanide ion affords benzoin as the product. This is a reversible
reaction, which means that the distribution of products is determined by the
relative thermodynamic stability of the products and starting material.

HE =, o

C Q _ .- electrophilic carkan 0 CN HO o

@kﬁ? e U @N{%H
11

O oot
HO CN H N
= R =)
nli[}ég;f:::H i

nuclscphilic carbon

mitnle enolate

ht 8
H=0 CN . M

AT
‘ O -
CH OH
R
J L
The benzoin condensation is in effect a dimerization and not a condensation
because a small molecule like water is not released in this reaction. For this reason the
reaction is also called a benzoin addition. In this reaction, the two aldehydes serve
different purposes; one aldehyde donates a proton and one aldehyde accepts a proton.
Some aldehydes can only donate protons, such as 4-Dimethylaminobenzaldehyde
whereas benzaldehyde is both a proton acceptor and donor. In this way it is possible to
synthesise mixed benzoins, i.e. products with different groups on each half of the

product. However, care should be taken to match a proton donating aldehyde with a
proton accepting aldehyde to avoid undesired homo-dimerization.
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Appendix IX
Oxidation of Benzoin to Benzil using nitric acid

Preparation of benzil can be done by the oxidation of benzoin using nitric acid, where

the OH group is converted to a ketone group.

o) OH 0 0
HNO;
+ N02
Benzoin Benzil
Mechanism:
o)

OH

Nya 8 o

"0—N{ -~
A C/O "
S ©

-
Nitric acid ‘
0 o)
H
) o)
\D/OH
N
+ HO/@\O
OH ©
/
HO—N\
O
O \ N// v o
- Hp
HO/+\OH NO.
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Procedure

1.

In a 250ml Erlenmeyer flask, mix 7.5g of benzoin and 30 ml concentrated nitric
acid.

Place the flask on a boiling water bath in the fume hood and heat for about Lhour
until the evolution of nitrogen oxides has ceased.

Pour the reaction mixture in about 100-150 ml of cold water in a beaker with

stirring .then Benzil separates out as yellow oil, which immediately solidifies.

4. Filter on a Buchner funnel.

5. Wash with cold water to remove the nitric acid.

6. Drain well and re-crystallize from ethanol. (After dissolving the product in hot

ethanol, add water dropwise to reach the cloud point and allow it to crystallize).
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